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The X’Pert Pro MPD has many different hardware configurations that can be used for different applications. This makes the X’Pert Pro MPD a versatile instrument. 

This SOP is written to describe the general user interface of the data collection software, X’Pert Data Collector, and to address all of the various hardware configurations and measurements that you might use the X’Pert Pro for. More streamlined and job-specific SOPs are available that cover specific procedures. They will assume that you are familiar with the software X’Pert Data Collector as described in this document. It is suggested that you use those SOPs to guide you in collecting data, and refer to this manual when you need clarification or additional detail.
There are 3 main pieces of the instrument that can be readily changed. These are the Incident-beam PreFIX modules, the Sample Stage, and the Diffracted-beam PreFIX modules. Unless you have received special training, you are not allowed to change these pieces; please notify X-ray SEF staff what pieces you want to use and I will try to make sure that they are in place before you use the instrument. 

Each piece has several accessories that can be changed. Standard training for the X’Pert Pro will teach you how to change these accessories. 

Additionally, there are two X-ray tubes available for the X’Pert Pro: a Cu tube and a Co tube. The Cu tube is usually in use; however, the Co tube will be installed for special projects. When the Co tube is inserted, certain PreFIX modules (such as the Mirror Cu w/Si (parabolic MPD)) cannot be used. When the Co tube is inserted, a notice will be posted on the Faces Schedule for the X’Pert Pro and at http://prism.mit.edu/xray/status.htm indicating when the Co tube will be removed. 

One attractive feature of the X’Pert Pro diffractometer is that all details about the instrument configuration are saved in each data file. Therefore, you can look in the file of a previous data set and see how those data were collected: how the instrument was configured and what scan parameters were used. 

All data collected with X’Pert Data Collector are saved in an ascii XML format known as XrdML. The file can be opened in word processors, including notepad; can be opened in web browsers; and can be opened with many XRD data analysis software packages. The XrdML schema is published at www.xrdml.com.
PANalytical X’Pert Pro Operation Checklist

	1. Reserve the instrument
a. Determine if the previous user is using a different configuration than you will

b. If so, email speakman@mit.edu and let me know that you will need the configuration changed
	Ch III

	2. Assess instrument status and safety 
a. Is the instrument on? 
b. Is the generator on? 
c. What is the tube power? 
d. Is the shutter open?
	Ch II

	3. Determine if the correct PreFIX optics and sample stage are on the instrument. 
a. If not, ask SEF staff to change them for you
	Ch V, Sect 3

	4. Turn the diffractometer on
	Ch IV, Sect 1

	5. Start X’Pert Data Collector
	Ch IV, Sect 2

	6. Connect the computer to the instrument
	Ch IV, Sect 2

	7. Make sure the tube power is at stand-by level: 
a. 40 kV and 10 mA for the Cu tube
b. 30 kV and 10 mA for the Co tube
	Ch V, Sect 2B

	8. Choose and insert accessories (slits, filters, etc) into the PreFIX modules
	Ch V, Sect 3

	9. Load your sample
	Ch V, Sect 3C

	10. Specify the instrument configuration in Data Collector
	Ch V, Sect 2D & E

	11. Turn the tube power up to full power
a. 45 kV and 40 mA for the Cu tube
b. 40 kV and 45 mA for the Co tube
	Ch V, Sect 2B

	12. Write a measurement program if you do not already have one
	Ch VI, Sect 2

	13. Run the measurement program
	Ch VI, Sect 3

	14. When finished
a. Retrieve your sample 
b. Clean the sample stage and sample holders 
c. Turn the tube power down to its stand-by level: 
i. 40 kV and 10 mA for the Cu tube
ii. 30 kV and 10 mA for the Co tube 
d. Copy your data to a secure location
	Ch VII
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This SOP was created by starting with the X’Pert Pro Quick Start Guide published by PANalytical Inc.

I. TERMS AND CONVENTIONS USED 

In this section, we describe the terms and conventions used in this SOP and how they relate to the user interface. 

Terms Used to Denote an Action 
In this guide there are several terms that indicate an action. 
	Click 
	Press the left mouse button and quickly release it.

	Double-click 
	Press the mouse button twice (quickly) on an icon, item, file, etc. 

	Right-click 
	Press the right mouse button and quickly release it.

	Check/Uncheck 
	Click in a check box (() to check it or uncheck it 

	Drag 
	Press and hold down the mouse button and move the pointer to define an area or move an object

	Enter 
	Type in information. This can be either text or numeri​cal data.

	Press 
	Press a key on the keyboard, or a push-button in a window.

	Select 
	Move the mouse cursor to the option you want and click the left mouse button.

	Toggle 
	Switch between parameters or states (for example: On-Off-On).

	Press [image: image1.jpg]


 
	In the examples in this Guide we terminate most actions by saying “press [image: image2.jpg]


”; you can usually press the Enter key instead.

	click (or press) [image: image3.jpg]


  
	The instruction to click (or press) [image: image4.jpg]


  is used in this Guide as an instruction to close the window that you are currently working in, not the program. The instructions may instead say “close this window”


Instructions and Descriptive Text 
An instruction is preceded by a bullet “(” or number. Any descriptive text relating to an instruction is given directly after the instruction. 

Generally, screen captures are preceded by an instruction and intend to reproduce what you will see on your screen. If there are any differences, follow the instructions.
Program Parameters
· Menu items are printed in italics, for example: File, Edit, etc

· Nested menus and selections within menus are indicated by >, for example File>Open, Control>Preferences
· Window titles (shown in the blue title bar of each window) are written in bold italics.
· Names of tabs are underlined.

· Icons or Buttons on a dialogue box that you should click are written in bold text or the actual button graphic is shown (for example: Apply or  [image: image5.jpg]Apply



 )
·  All fields are shown in bold between “quotation marks”. 

II. INSTRUMENT SAFETY

Pictured below, in Figure 2.1, is the X’Pert Pro MPD. There are three primary features that you should be aware of. The X-Rays On light on top of the diffractometer is your first safety indicator; it is lit when the generator is turned on. The front control panel includes additional safety and instrument status indicators. A close-up of the front control panel is shown in Figure 2.2. The enclosure doors are leaded so that they are radiation shielding. Before the shutter can open, these doors will lock—thereby preventing you from entering the enclosure when there is a danger of exposure.
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There are four safety questions to ask yourself when using the PANalytical X’Pert Pro MPD. They are: “is the instrument on?”, “is the generator on?”, “what is the tube power?”, and “is the shutter open?”

Is the instrument on?

When the instrument is off, either the Standby indicator light on the front control panel (Fig 2.2) will be lit or no lights on the front control panel will be lit.

When the instrument is on, the Power On indicator light will be lit. 
When the instrument is on, the generator is not necessarily on.  If the generator is not on, no X-rays will be produced and the instrument is safe.
Is the generator on?

When the generator is on, the large X-Rays On light on top of the diffractometer will be lit (Fig 2.1). The X-RAYS ON indicator light on the front control panel will also be lit. 

Even if the generator is on no X-rays will be produced if the tube power is low.

What is the tube power?

The tube power is indicated on the front control panel by the kV and mA digital meters. The tube power may also be indicated by the X’Pert Data Collector software if it is running.

The lowest power is 15 kV and 10 mA. When at this power, few X-rays are produced by the X-ray tube. Stand-by power is 40 kV and 10 mA. At this setting, a low power X-ray beam is produced. This is the power you should set the generator to when you are finished with your data collection. The operating power is 45 kV and 40 mA for the Cu tube and 40 kV and 40 mA for the Co tube. At this power, the X-ray tube is producing the maximum flux of X-rays. The instrument is still safe as long as the shutter is closed. 

Is the shutter open?

When the shutter is open, the yellow-green shutter open light on the X-ray tube tower will be lit. Also, the Shutter Open LED on the front panel will display a vertical line. Most importantly, when the shutter is open the doors to the diffractometer enclosure will be locked. This means that you cannot get into the instrument while the shutter is open. You should still look at the shutter open light before attempting to open the doors, however, just to be cautious. 

When the shutter is closed, no X-rays are leaving the X-ray tube tower and the instrument is safe. However, when working inside the instrument (to change samples, to change accessories) you should lower the tube power to 40 kV and 10 mA in order to lessen the chance of radiation exposure.
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Figure 2.2 The front control panel for the X’Pert Pro MPD.

III. Reserving Instrument Time 
The X’Pert Pro MPD has many different hardware configurations that can be used for different applications. There are 3 main pieces of the instrument that can be readily changed. These are the Incident-beam PreFIX modules, the Sample Stage, and the Diffracted-beam PreFIX modules. 
The PreFIX modules are usually configured to support one of two modes: 

· High Speed Mode uses the Programmable Divergence Slit and X’Celerator Detector

· Parallel-beam Mode uses the X-ray Mirror and Parallel Plate Collimators

The Sample Stages include a 15 Position Sample Changer, Open Eularian Cradle (OEC), Furnace, Cryostat, and a Spring-Clip Sample Holder.
Unless you have received special training, you are not allowed to change these pieces. Therefore, we must work together to make sure that you can use the instrument in the configuration that you want. 
When you want to reserve the X’Pert Pro, you should:
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Reserve instrument time using the Online Scheduling
· When you make a reservation, choose an option from the drop-down menu to indicate what configuration you will use. 

2. Look at the reservation before yours. See what configuration the previous user will be using.

· If the configuration is different than yours, then email X-Ray SEF Staff and let them know when you will need the configuration changed.

3. When you arrive to use the instrument, make sure that the PreFIX modules and sample stage are the ones that you want to use.

· If the wrong modules are installed on the instrument, find an X-Ray SEF Staff who can reconfigure the instrument for you.
Each piece has several accessories that can be changed. Standard training for the X’Pert Pro will teach you how to change these accessories, as described in Section 5.
Additionally, there are two X-ray tubes available for the X’Pert Pro: a Cu tube and a Co tube. The Cu tube is usually in use; however, the Co tube will be installed for special projects. When the Co tube is inserted, the Parallel-beam mode, with the X-Ray Mirror, cannot be used. When the Co tube is inserted, a notice will be posted on the Faces Schedule for the X’Pert Pro and at http://prism.mit.edu/xray/status.htm indicating when the Co tube will be removed. 

IV. Starting the Diffractometer and Software
The guidelines in this section will walk you through turning the diffractometer on and starting X’Pert Data Collector. X’Pert Data Collector, hereafter just referred to as Data Collector, is the software that is used to operate the PANalytical X’Pert Pro MPD. 
4.1 Turning the Diffractometer On

4.2 Starting the Data Collection Software

4.3 Configurations of the X’Pert Pro MPD

4.1 Turning the Diffractometer On

Buttons and indicator lights referenced in this section are on the front control panel, shown below in Fig 4.1

[image: image8.jpg]Power On Standby HT HT
Button Button Key Indicator
Light

Power On

Indicator ﬁ}ij?él:tc(;)rn
Light Light
Shutter Open
LED

Standby kv mA
Indicator meter meter
Light




Figure 4.1 The front control panel for the X’Pert Pro MPD

1. Look at the Power On and HT indicator lights to determine if the generator is on.

a. If both lights are on, then the generator is on. Proceed to Section 4.2
b. If both lights are off, then proceed to step 2

2. Make sure that the enclosure doors are closed

3. Check if the HT indicator light on the front control panel is lit. 

a. If it is, proceed to step 4.

b. If it is not, turn the HT key (above the HT light) clockwise.

i. The HT indicator should light up.

ii. Proceed to step 4.

4. Press the Power On button on the front control panel. 

a. If everything works properly

i. The Standby indicator light will turn off
ii. The Power On indicator will light up
iii. The system will start an initialization process. 

iv. The tube power will be turned to 30 kV and 10 mA

v. The tube and detector will be moved to their starting positions
vi. The diffractometer is now on. Proceed to Section 4.2 to start Data Collector.
b. If the above actions do not happen, look at the Shutter Open LED
i. If there are three moving dots in the Shutter Open LED, then the enclosure doors are not properly closed or the HT key is not turned. Go back to step 2.

ii. If the doors and HT key are ok, you will need to contact SEF staff
4.2 Starting the Data Collection Software

Before starting the data collection software, X’Pert Data Collector, you should make sure that the correct hardware is installed in the diffractometer. It is especially important that the correct sample stage is installed; if it is not, follow the instructions in Section 5.3C or contact the X-Ray SEF Staff for help.
1. Determine if X’Pert Data Collector is already running.

a. Each user has a user account in Data Collector. You can determine what user is logged-in to Data Collector by looking in the title bar of X’Pert Data Collector (in the example below, the user “Powder Diffraction” is logged-in) [image: image9.jpg]{8 xPert Data Collector, [Powder Diffraction]
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b. If Data Collector is logged-in to your account, you can skip to step 4 or to configuring the instrument, Section 5
c. If Data Collector is not logged-in to your user account, you should quit Data Collector. Before quitting Data Collector, make sure a run is not in progress. 
2. Start X’Pert Data Collector. 

a. Either double-click on the desktop icon, double-click on the Quick Launch icon, or select the shortcut in the Start Menu> Programs> PANalytical> X’Pert Data Collector. 
3. Enter the user name and password and press [image: image10.jpg]


  .
a. The current password for all users is soap
4. In X’Pert Data Collector, select Instrument> Connect. 
5. Choose the correct configuration for your sample stage. 
a. See section 4.3, if you need any clarification on the different configurations. 
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6. Press [image: image12.jpg]


.

a. If everything works correctly, you will get a message showing how the computer thinks the instrument is configured. 
i. Click [image: image13.jpg]


, even if there is a mistake. You will fix errors in the next step.

ii. You are now ready to proceed to Section 5, configuring the hardware.

b. After you press [image: image14.jpg]


, you might get an error message saying that the correct sample stage is not installed. If you get the following error message, then:           [image: image15.jpg]XPert Data Collector;
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i. Press [image: image16.jpg]


.

ii. Go to Tools> Exchange Sample Stage [image: image17.jpg]@ xPert Data Collector [User-1]
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In the dialogue box: 
1. The “Active sample stage” is the stage that the computer thinks is connected. 
2. In the drop-down menu “Change to sample stage”, pick the sample stage that you want to use. 
3. Press [image: image18.jpg]



iv. In the next dialogue box(es), press Next.
v. In the final dialogue box, press Finish.
vi. It may take a couple of minutes for the computer to execute the command. 
vii. Return to step 3 above. 
4.3 Configurations of the X’Pert Pro MPD
There are currently five configurations for the X’Pert Pro MPD, each corresponding to a specific sample stage. In the future, more configurations may be added that correspond to different settings for the same sample stage: for example, one configuration for heating the furnace quickly with some temperature overshoot and another configuration for operating the furnace slowly but with more accurate temperatures. 

If you are not sure what sample stage you are using, see Section 5.

V. Setting up the Hardware

This section describes how to change the accessories for PreFIX optics modules and how to properly configure the X’Pert Data Collector software. Details on how the optics work are provided in Appendix A. A list suggesting what configurations to use for different types of data collection is provided in Appendix B. 

5.1 Explaining PreFIX Modules
5.2 Specifying the Instrument Configuration in Data Collector

A. The Generic Process for Changing a Setting

B. Changing the Tube Power

C. Changing the Goniometer Position

D. Changing the Incident-beam Configuration

E. Changing the Diffracted-beam Configuration

5.3 How to Change Optical Accessories for PreFIX modules


A. Incident-beam PreFIX modules


B. Diffracted-beam PreFIX modules


C. Sample Stages

Appendix A: Description of PreFIX modules and the accessories that are available

Appendix B: Guide to Choosing what PreFIX modules and accessories to use

5.1 What are PreFIX modules, and how does this whole thing fit together?
The PANalytical X’Pert Pro features interchangeable modules for the optics on both the incident- and diffracted-beam sides; these are called “PreFIX Modules”. The PreFIX modules permit the diffractometer to be easily reconfigured as appropriate for individual experiments. For each PreFIX module there is a range of accessories and settings that can be optimized for a given experiment.
The typical training for the X’Pert Pro will teach you how to change the accessories and settings of the PreFIX optics; however, it will not authorize you to change the PreFIX optics themselves. If you want the PreFIX optics changed, then you should request help from SEF staff. 
When configuring the instrument for data collection, you specify in Data Collector what optics you want to use. Data Collector will automatically change the optics that it can; and it will prompt you when you are required to make a physical change to an optical accessory. Section 5.2 below describes how to make changes in the Data Collector software; section 5.3 describes how to change the physical hardware. 
5.2 Configuring the Data Collector Software
Typically, users are not allowed to change the PreFIX modules on the X’Pert Pro. However, users can change the accessories in a PreFIX module. There are two types of accessories for the X’Pert Pro: those that are computer controlled and those that are manually manipulated. For both types of accessories, you must tell the computer what the settings are. In some cases, such as computer controlled accessories and detectors, this is important for the instrument to operate correctly; for others, such as manual accessories, this is used just for record keeping purposes- all details about the instrument configuration are recorded in the diffraction data file for every scan. 

A Generic process to change a setting

B Change the Tube Power

C Change the Goniometer Position

D Change the Incident-beam Optics

E Change the Diffracted-beam Optics
A. The Generic Process for Changing a Setting
The instrument configuration is set in the Instrument Window of the Data Collector software. It contains three tabs (seen in Fig 5.1): Instrument Settings, Incident Beam Optics, and Diffracted Beam Optics.
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Figure 5.1 The Instrument Window of X’Pert Data Collector
The Instrument Settings tab contains generator and goniometer settings. This includes the ability to change the tube power (on/off, kV and mA settings); to change the goniometer position (detector position 2theta, tube position omega, etc.); and to manually open or close the shutter. 

The Incident Beam Optics tab and Diffracted Beam Optics tab contain settings for the incident-beam and diffracted-beam optics, respectively. Use these tabs when you are configuring the instrument before collecting data. 

The generic process to change instrument settings is:

1. Click on the tab that includes the setting that you want to change

a. the tabs define categories of settings that you can configure

2. In the hierarchal tree, double-click on the item that you want to change

a. the resulting window will allow you to change all settings in that category, not just those for the item that you want to change

3. In the window that opens, click on the tab for the setting that you want to change

4. Change the value

5. Click on Apply or OK
a. clicking on Apply will change the value and then leave the window open

b. clicking on OK will change the value and then close the window
B. Changing the Tube Power

1. Go to the Instrument Settings tab in the Instrument Window
2. Double-click on Generator
3. If the Generator is off, then check the box next to “Generator On” and click Apply
4. Change the tube power

a. Change the values of “Tension (kV)” and “Current (mA)” to the desired values, and then click on OK. 
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For the Cu tube

i. Collect data at full power: 
1. “Tension”= 45 kV
2. “Current”= 40 mA

ii. When done, turn the power down to its stand-by level:

1. “Tension”= 40 kV

2. “Current”= 10 mA

c. For the Co tube

i. Collect data at full power: 

1. “Tension”=40kV

2. “Current”=45mA

ii. When done, turn the power down:

1. “Tension”= 30 kV
2. “Current”= 10 mA
5. When working inside the enclosure (loading sample, changing accessories, etc) 

a. the tube power should be at its stand-by level (ex. 40 kV and 10 mA for the Cu tube)

b. turn the tube power up to full power when you finish working inside the enclosure

6. To turn the tube power off, uncheck “Generator On” and click OK.

C. Changing the Goniometer Position

You can manually change the position of the X-ray tube or detector; with the Open Eularian Cradle (OEC), you can also change the rotation and tilt of the sample. 

5. Go to the Instrument Settings tab in the Instrument Window
6. Double-click on Positions
7. In the Instrument Settings  window:

a. To move the detector, change the value “2Theta” and click Apply
b. To move the tube position (omega), you need to change the value of “Offset”.

i. The X-ray tube’s position will be equal to ½*2Theta + Offset

ii. Change the value “Offset” to the desired value and click Apply
c. To rotate the sample (OEC only), change the value “Phi” and click Apply
d. To tilt the sample (OEC only), change the value of “Psi” and click Apply
D. Changing Incident-beam Configuration
This section will not describe how to set every Incident-beam setting. Most settings require the same simple process of selecting your desired optic from a drop-down list. 
Each time you change the configuration settings for an optic, you should click Apply. If the computer can change the setting automatically, it will. If the change requires a hardware component to be changed, Data Collector will prompt you to change that accessory. 
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· If you have already changed that accessory, then click OK. 

· Otherwise, follow the instructions and change the appropriate accessory in the instrument. Then click OK. 

1. Choose the Incident Beam Optics tab in the Instrument Window
2. Double-click on Incident beam path
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3. Choose the PreFIX Module tab in the Incident Beam Optics window


a. The two options are the Mirror or the Programmable Divergence Slit (PDS)  

b. If necessary, select the PreFIX module that you are using from the drop-down list and then click Apply. 
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4. Go to the Divergence Slit tab

a. The options here depend on which PreFIX module is selected.

b. If using the Mirror:
i. Select the divergence slit you want from the “Type” drop-down menu and click Apply. 

ii. The value of “Distance to sample (mm)” should always be “140”. 
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c. If using the Programmable Divergence Slit:
i. In the “Usage” field, you must choose between “Fixed” or “Automatic”
ii. If using “Fixed” mode, then select the divergence slit size you want from the “Aperture” drop-down menu and click Apply
iii. If using “Automatic” mode, then enter the value for “Irradiated Length” 

1. In general, “Offset” should always be “0”. 

iv. See Appendix A for a description of the differences between these options
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5. Go to the Anti-scatter Slit, Soller Slit, Mask, and Filter tabs
a. In each tab, select the value from the drop-down menu, then click Apply
b. For the anti-scatter slit “Type”, only “None” or “AS Slit 1.4mm (mirror)” work with the Mirror. All other options work with the PDS PreFIX module.

c. The Filter “Type” should almost always by “None”. 

d. The Masks for the PDS PreFIX module start with “Inc. Mask Fixed … (MPD/MRD)”, while the Masks for the Mirror PreFIX module start with “Mask Fixed …”. The “Distance to sample (mm)” should always be “140”. 
6. Go to the Beam Attenuator tab

a. When using the PDS PreFIX module, the “Type” may be set to “None”, “Cu 0.1 mm manual” or “Cu 0.2 mm manual”. 

b. When using the Mirror PreFIX module, the “Type” may be set to “Ni 0.125 mm automatic”, “Cu/Ni 0.2/0.02 mm manual” or “Cu 0.10 manual (mirror/hybrid)”

i. If you want to use the automatic beam attenuator and it is not already installed, then you must contact SEF staff to change it for you.

c. There are 3 “Usage” modes: 

i. The “At pre-set intensity” usage will pause the scan and insert the attenuator when the intensity reaches the “Activate at level” value (usually 500,000cps)
ii. The “At pre-set axis position” usage will pause the scan and insert the attenuator when the axis specified in “Use with axis” (usually 2Theta or Omega) reaches the “Activate range”. 

iii. The “Do no switch” usage will have the attenuator always inserted if the “Activated” box is checked; or always out if the “Activated” box is unchecked. 

1. If using the “Ni 0.125 mm automatic” attenuator, then the attenuator will be automatically inserted/removed when the proper condition is achieved.

2. If using a manual attenuator: when the attenuator must be changed (inserted or removed), then Data Collector will pause the scan, close the shutter, and prompt you to change the attenuator. The scan will not continue until you acknowledge the prompt (click OK). Be sure the change the attenuator as instructed before clicking OK.

d. Do not change the “Attenuation Factor”
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7. Click on OK to save changes and close the Incident Beam Optics window

E. Changing Diffracted-beam Configuration
1. Choose the Diffracted Beam Optics tab in the Instrument Window
2. Double-click on Diffracted beam path 

3. Choose the PreFIX Module tab

a. Options include different Parallel Plate Collimators or the X’Celerator detector
b. If the PreFIX module that you are using is not already selected, then select it from from the drop-down list and the click Apply. 
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4. Go to the Anti-scatter Slit tab

a. The options here are different depending on which PreFIX module you are using.

b. If using the Mirror, then “Type” should be set to “None”. 

c. If using the PDS, then “Type” should be “Prog. AS Slit”. 
i. In the “Usage” field, select “Fixed” or “Automatic”.

ii. If using “Fixed” mode, then select the anti-scatter slit size you want from the “Aperture” drop-down menu and click Apply
iii. If using the “Automatic” mode, then type in your desired value for “Observed Length”. 

iv. In general, the “Usage” and “Aperture” or “Observed Length” for the programmable anti-scatter slit on the diffracted-beam side should be the same as the values for programmable divergence slit on the incident-beam side
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5. Go to the Receiving Slit, Filter, Mask, Soller Slit, Monochromator, and Beam Attenuator tabs.
a. In each tab, select the value from the drop-down menu and click Apply
b. The Receiving slit “Type” should be “None” for the X’Celerator, and either “None” or “Parallel Plate Collimator Slit” for the parallel plate collimators
c. The Mask “Type” should always be “None”
d. In Monochromator, the “Diffr Beam Flat 1x graphite” works only with the Mirror PreFIX module, and the “Diffr. Beam Flat 1x graphite for Cu (X’Cel)” works only with the X’Celerator PreFIX module

6. Go to the Detector tab

a. When using the parallel plate collimators, this should be set to “PW3011/20 (Miniprop. Large window)[1]”
i. The “Used Wavelength” should be “K-Alpha1”. 

ii. Do not click on Set PHD Levels
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b. When using the X’Celerator, this should be set to “X’Celerator[2]”

i. The X’Celerator has two “Usage” modes, “Scanning” or “Receiving slit”
ii. For high-speed mode, select the “Scanning” usage and then set the “Active angle”, which should be between “0.518” and “2.122” °2Theta

iii. To use as a point detector, select the “Receiving slit” usage and then set the “Active length”, which should be between “2.17” and “8.89” mm. 
iv. The “Used Wavelength” should always be “K-Alpha1” 
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7. Click on OK to save changes and close the Diffracted Beam Optics window

5.3 How to Change Optical Accessories for PreFIX modules
A. Incident-beam PreFIX Modules

There are two options for the incident-beam PreFIX modules, a programmable divergence slit (PDS) and an X-ray mirror. This section first describes how to change the optics for each; first for the Mirror and then for the PDS. Appendices A and B describe how the optics function and how to choose what to use. 
(1) Mirror Cu W/Si (parabolic MPD)

The graded multilayer parabolic X-ray mirror (i.e. Göbel mirror) is a beam conditioner that is able to convert the divergent X-ray beam into an intense monochromatic quasi-parallel beam. 

[image: image34.jpg]Divergence Beam Mask or Soller Anti-scatter
Slit Attenuation Foil Slit Slit
. T ‘ L] St

L L





Figure 5.2 Illustration of PreFIX mirror and its accessories 
Accessories for the mirror are contained in the wood box labeled “Accessories for parallel beam optics”. Accessories and settings for the mirror, from those closest to the beam to those furthest away, include:
Divergence Slit: Choose the ½°, ¼°, 1/8°, 1/16°, and 1/32° divergence slit. Insert the divergence slit in the first slot, closest to the X-ray tube (Fig 5.2). When inserting the slit, you should hold it on the end that has the slit size stamped into the metal. The smooth side of the divergence slit should be facing away from the X-ray tube. The divergence slit will ‘click’ into place twice; stop the second time it clicks into place. If the slit is not going in easily, try lifting slightly on the end that you are holding. 
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Beam Attenuator or Beam Mask: The second slot on the Mirror PreFIX module can hold a manual beam attenuator, a beam mask, or nothing. Choose the mask or attenuator and insert it until it clicks in place. Stop the first time it clicks into place. 
When inserting the beam attenuator, hold it by the end on which the label is stamped. The label should face away from the X-ray tube; the notched side should face towards the X-ray tube. 

The beam mask has two different sizes cut into each insert. The side with the size mask that you want should be inserted into the slot. The notched side should face towards the X-ray tube. 
Soller Slit Housing or Automatic Beam Attenuator: Either a holder for a Soller slit or an automatic beam attenuator can be mounted on the end of the Mirror PreFIX module, as shown in Fig 5.3. Only SEF staff are authorized to remove and attach either of these accessories. 
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Figure 5.3 Picture of the mirror with the automatic beam attenuator (left) or the Soller slit housing (right).
Anti-scatter slit: Both the Soller slit housing and the automatic beam attenuator can hold the optional 1.4mm anti-scatter slit. 

To insert the anti-scatter slit into the slot in the Soller slit housing (Fig 5.2), hold onto the end that is labeled and insert it until the first time it clicks into place. The side with 1.4 stamped into the metal should be facing away from the X-ray tube. 

The anti-scatter slit is screwed onto the front of the automatic beam attenuator. This should only be done by SEF staff. 

Soller Slit: The Soller slit may consist of 3 pieces: the actual Soller slit, facing plates, and a shutter lever (ie leg). The Soller slit for the mirror PreFIX module should have facing plates but no shutter lever. If you cannot find the correct type in the size that you want, contact the SEF staff.  
The sizes of the Soller slits, 0.04rad, 0.02rad, and 0.01rad, are written on the end of the handle. Hold the Soller slit by the handle and insert it all the way into the Soller slit housing. The number on the end of the handle should read right-side up. Do not touch the delicate foils when handling the Soller slits. 
Soller slits are stored on the right-most ledge inside the diffractometer. 
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Figure 5.4 Picture of 0.02rad Soller Slit with facing plate and without shutter lever
(2) Prog. Div. Slit & Anti-scatter Slit

The programmable divergence slit (PDS) PreFIX module is built around a computer-controlled divergence slit to limit the equatorial divergence of the X-ray beam. The configuration of the programmable divergence slit can be controlled from the Data Collector software.
On the Data Collection computer for the PANalytical X’Pert Pro, there is an MS Excel workbook called “X'Celerator Calculation Sheet.xls”. The workbook can be used calculate the length of the X-ray beam for a given divergence angle (the Constant Divergence Angle worksheet) or the divergence angle of the X-ray beam for a given irradiated length (the Constant Illuminated Length worksheet). 
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Figure 5.5 Illustration of Programmable Divergence Slit and its accessories 

Accessories and settings for the Programmable Divergence Slit, from closest to the X-ray tube to furthest away, include:

Beam Attenuator or Filter: The first slot in the PDS, just before the Soller slit, can hold an attenuator foil or an incident beam beta filter foil. Either the attenuation foil or the beta filter should be held by the largest end, on which the label is stamped, and slid all of the way into the slot. The side of the foil with the rivet should face towards the X-ray tube. 

Soller Slit: Either a 0.04rad, 0.02rad, or 0.01rad Soller slit can be inserted into the Soller slit housing. The Soller slit may consist of 3 pieces: the actual Soller slit, facing plates, and a shutter lever (see Fig 5.4). The Soller slit for the PDS module should have facing plates and the shutter lever (i.e. leg). Soller slits are stored on the right-most ledge inside the diffractometer. If you cannot find the correct type in the size that you want, contact the SEF staff.  

Hold the Soller slit by the handle and insert it all the way into the Soller slit housing. The number on the end of the handle should read right-side up, with the shutter level facing down. Do not touch the delicate foils when handling the Soller slits. 

Mask: The mask limits the width of the incident X-ray beam. The mask can be 20, 15, 10, or 5 mm wide. To remove the mask from the PDS, a small screw driver needs to be fed through the hole at the top center of the mask; the mask should then be carefully worked out. To insert the mask, hold it by the top and press it down all of the way into the slot. The label stamped into the mask should be facing away from the X-ray tube when it is inserted. 
Fixed Anti-Scatter Slit: A fixed anti-scatter slit is attached to the end of the PDS module. The slit should be held by the end with the label stamped into it. It should be slid into the holder until the first time it clicks into place. The smooth surface of the anti-scatter slit should face away from the X-ray tube. 
B. Diffracted-beam PreFIX Modules
There are three diffracted-beam PreFIX modules. The appearance and accessories for two of these modules, the 0.27° parallel-plate collimator and the 0.09° parallel-plate collimator, are identical. The process for changing their accessories is described in the first section. The third module is the X’Celerator PreFIX module, which is described second. 

(1) Parallel Plate Collimators

The parallel plate collimator PreFIX modules consist of a set of parallel plates that define the equatorial acceptance angle seen by the detector. The two collimators have a 0.09° acceptance angle and a 0.27° acceptance angle. Both modules are always used with the mini-prop detector. 
The label on top of the parallel plate collimator has a line that reads: “PW 3098/09” or “PW 3098/27” for the 0.09° parallel plate collimator and the 0.27° parallel plate collimator, respectively. The location of this label is indicated in Fig 5.6
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Figure 5.6 Illustration of Parallel Plate Collimator PreFIX module
Inserts and settings for the Parallel Plate Collimators, in order from those closest to the sample to those furthest away, include:

Receiving Slit (Collimator Slit): A Parallel Plate Collimator Slit can be inserted into the module. There is a different slit for each parallel plate collimator; they are labeled 0.09 and 0.27 to indicate which parallel plate collimator they should be used with. The collimator slit should be held by its handle and slide all of the way into the first slit of the PreFIX module. 
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Soller Slit: Either a 0.04rad, 0.02rad, or 0.01rad Soller slit can be inserted into the Soller slit housing. The Soller slit may consist of 3 pieces: the actual Soller slit, facing plates, and a shutter lever (i.e. leg). Any Soller slit with any combination of these pieces can be inserted in the parallel plate collimator; however, the preferred Soller slit is one without a facing plate and without a shutter lever (see Fig 5.9). Soller slits are stored on the right-most ledge inside the diffractometer. If you cannot find the correct type in the size that you want, contact the SEF staff.  
There is a label on the end of the handle of the Soller slit indicating its size. To insert the Soller slit, hold it by its handle with the label facing right side up. Insert it all the way into the Soller slit housing. The slit will snap into place. The slit housing is wider than the Soller slit, allowing the slit to be inserted a little bit more forward or a little bit more backward. The proper position for the slit is centered; this can be done by lining up the holes in the Soller slit with the screw holes in the parallel plate collimator (illustrated in Fig 5.7). The positioning of the Soller slit does not have to be exactly perfect. Do not touch the delicate foils when handling the Soller slits.
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Figure 5.7 Insertion of Soller Slit into housing, lining up screw holes

Monochromator: A diffracted beam flat crystal monochromator can be installed between the parallel plate collimator and the detector.  This must be done by SEF staff. 
We do not have an anti-scatter slit, filter, or beam attenuator for the parallel plate collimators.

(2) X’Celerator or X’Celerator with Monochromator Cu
The X’celerator PreFIX module consists of a programmable anti-scatter slit (PASS) and the high-speed X’Celerator detector. The Programmable Anti-scatter slit is a computer-controlled optic; its configuration can be changed in Data Collector. The X’Celerator detector also has several settings that can be changed in Data Collector.
Settings for the X’Celerator detector and PASS are configured in Data Collector. 
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Figure 5.8 Illustration of X’Celerator and its accessories

Accessories that can be changed for the X’Celerator detector, listed in order from those closest to the sample to those furthest away (and closest to the detector) include: 

Soller Slit: Either a 0.04rad, 0.02rad, or 0.01rad Soller slit can be inserted into the Soller slit housing. The Soller slit may consist of 3 pieces: the actual Soller slit, facing plates, and a shutter lever (ie leg). The Soller slit for the X’Celarator module should not have facing plates or a shutter lever (see Fig 5.9). Soller slits are stored on the right-most ledge inside the diffractometer. If you cannot find the correct type in the size that you want, contact the SEF staff.  

Hold the Soller slit by the handle and insert it all the way into the Soller slit housing. The number on the end of the handle should read right-side up. Do not touch the delicate foils when handling the Soller slits. 
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Figure 5.9 Soller slit without facing place and without shutter lever (i.e. leg)

Beam Attenuator or Filter: a beam attenuator foil or beta filter foil can be inserted in front of the detector. To insert, simply hold the foil by the handle (the end with the label stamped into it) and slide it all the way into its slit. The side of the foil with the rivet should be facing away from the detector. The beta filter foil is most commonly inserted in this slot; if a beam attenuator is required, it is usually inserted in the incident-beam side optics.

Monochromator: A diffracted beam monochromator can be installed between the PASS and X’Celerator detector. Only SEF staff may insert/remove this optic. 
C. Sample Stages
We have five sample stages, the sample changer, the open Eularian cradle (OEC), the spring-loaded sample holder, the furnace, and the cryostat. 
The furnace and the cryostat can only be set up and removed by SEF staff. The sample changer, OEC, and spring-loaded sample holder can be changed by properly trained users. 

(1) Mounting Sample Stages
All sample changes use the same general procedure to change sample stages. However, because the furnace and cryostat have additional complications due to their cables and connections, most users will not be authorized to change them. The sample changer, OEC, and spring-loaded sample holder can be changed by users. Particulars related to using each stage are discussed in later sections. This section describes the general procedure for changing these sample stages: 
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Figure 5.10 Illustration of how a sample stage is mounted on the goniometer

1. Remove the four thumbscrews that are holding the stage in place. 

a. The hinged clip will support the stage so that it will not fall.

2. Holding the stage, lift up the hinged clip and pull the sample stage off of the goniometer

a. Alternatively, you can swing out the bottom of the sample stage and then pull it out and down to remove it from the goniometer

b. Be sure not to drop the sample stage

3. The sample spinner and OEC stay in the enclosure at all times. 
a. Sit them on the bottom of the enclosure, being careful not to twist or put stress on the cables attached to the stage. 
b. Be careful of motors and other moving parts; do not hold the stage by the motor, moving part, or cable, and do not set the stage down on any of these parts.
c. The sample spinner is usually placed on its side in the front center or front left-center of the enclosure.

d. The OEC is usually placed in the front right-hand corner of the enclosure.

e. The spring-loaded sample holder is stored in the cabinet when not in use.

4. Bring the new sample stage into position so that it fits over the alignment blocks and so that the hinged clip holds it in place. 

a. You can either:

i. hold the hinged clip up as you slide the stage into place; or

ii. you can slide the top of the stage into place under the clip first, and then swing the rest of the stage into place. 
b. Make sure that you do not twist or stress any cables when you mount the stage.

c. Do not touch the alignment blocks; they are easily corroded by the oils on your fingers.

d. Make sure the hinged clip engages the stage and is holding it before you let go.

5. Use the four thumbscrews to tighten the stage into place

a. Each thumbscrew should have a split washer and a solid washer with it
b. Tighten the thumbscrews firmly, but do not overtighten them. 

6. After changing the stage, you should use the sample exchange wizard to tell Data Collector that you are changing it. 

a. If you are already connected to the instrument, you will have to go to Instrument > Disconnect before you can run the sample exchange wizard. 

b. Go to Tools> Exchange Sample Stage
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c. In the dialogue box:
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i. the sample stage that the computer thinks is connected is listed as the “Active sample stage”. 
ii. In the drop-down menu for “Change to sample stage”, pick the sample stage that you want to use. 
iii. Press [image: image49.jpg]



d. In the next dialogue box, press Next.
e. In the next dialogue box, press Finish.
f. It may take a couple of minutes for the computer to execute the command. 
g. Go to Instrument > Connect and connect Data Collector to the instrument. See section 4.2 for additional details on this process.

(2) Sample spinner and changer
The sample changer consists of two parts: the sample spinner, which attaches to the goniometer and holds the sample that is being irradiated; and the sample changer, which holds up to 15 samples and contains the robotic arm for automatically loading and removing samples from the sample spinner.

The sample spinner should be mounted as described above in section (1) above. 
There are two black locking knobs that are used to hold the sample changer in place. 
To lock these black knobs, rotate them about 90° clockwise until the knob alignment snaps down into place. 
To unlock the black knob, lift up and rotate the knob about 90° counter-clockwise until the alignment pin is held up and out of the locking position. 

When not in use, the sample changer is stored in the front left corner of the enclosure. It is locked into place with the black locking knob that is closest to the center of the enclosure. 
To move the sample changer for use
1. Make sure the sample spinner is installed according to the instructions in section (1)
a. Before step 6 of the instructions above in section (1), you should position the sample changer using the instructions below. Then perform step 6 as described in section (1) 

2. Unlock the black locking knob that is closest to the center of the enclosure
3. Roll the sample changer away from the corner and turn it 90° clockwise, so that the armature is closer to the goniometer and the sample magazine is closer to the front of the enclosure. 
4. Roll it to the right, to the center of the enclosure, so that it goes over the base plate. 
5. Line up the right-hand side of the sample changer base with the line marked on the base plate. 
6. Lock both of the black locking knobs. 
a. You may have to move the sample changer slightly to ensure that both of the alignment pins lock into place. 
7. Load the round sample holders into the magazine, and then place the sample magazine in the sample changer (Fig 5.11)
a. The magazine is inserted so that the to alignment holes go over the alignment pins 
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Figure 5.11 Inserting and removing the sample changer magazine

To remove the sample changer

When the sample changer is not being used, it is stored in the front left-hand corner of the enclosure. 
1. In Data Collector 

a. go to the Instrument Settings tab

b. double-click on Sample Stage
c. double-click on Reset
2. In the enclosure

a. Unlock the black locking knobs

b. Roll the sample changer to the left until it clears the base plate

c. Rotate the sample changer 90° counter-clockwise, so that the long edge of the sample changer is aligned with the front wall of the enclosure and then sample magazine is towards you. 

d. Roll the sample changer so that it is in the front left-hand corner

e. Use the black locking knob nearest to you to lock the sample changer into place

(3) Open Eularian Cradle (OEC)
The OEC sample stage attaches to the goniometer as described above in section (1). The sample stage has several alternative platforms, described in Appendix A. These can only be changed by SEF staff. 

Usually the Z translation stage will be mounted in the OEC. This stage allows the sample height to be translated by 10mm so that the sample surface can be properly aligned. 

To adjust the sample height

1. attach the dial gauge to the dial gauge holder 
a. there is an alignment slot in the dial gauge base which slides over the alignment pin on the dial gauge holder

b. the dial gauge only slides onto the dial gauge holder easily if it is being held perfectly straight up-and-down and at the proper rotation

c. tighten the knurled knob

2. Position the sample under the dial gauge
3. Rotate the sample platform until the dial gauge reads 1mm 
a. Rotate the sample platform clockwise to lower the stage

b. Rotate the sample platform counter-clockwise to raise the stage

c. On the dial gauge, 

i. the inner scale, with the small needle, is marked in 0.2mm increments

ii. the outer scale, with the large needle, is marked in 0.002 increments; the upper half of the scale is used when the 1/10mm increment is even, the lower half of the scale is used when the 1/10mm increment is odd
iii. as a consequence, at 1mm the small needle will point to 1 on the inner scale and the large needle will point upwards towards 0 on the outer scale

d. If your sample is delicate and you do not want to risk having the dial gauge head damage it, then you can:

i. Use a sample of identical thickness to adjust the sample stage height

ii. If your sample is less then 1 mm thick, then you can measure its thickness using calipers, position the sample stage without a sample to a height of 1mm minus your sample thickness, and then put your sample on the stage

4. Remove the dial gauge.
[image: image51.jpg]Knurled ’
‘| Knob

|
| e s i

Rt

R—

: 4
R

Sample Dial Gauge
Platform Holder

',4:,»




Figure 5.12 Illustration of the Open Eularian Cradle 

(4) Spring Loaded Sample Holder for Flat Specimens
This sample stage holds a flat specimen or flat sample holder (such as that used for the Rigaku powder diffractometer) between a sample clamp and a spring. 

To load a sample:

1. With forefinger, pull down the spring

2. Slide the sample between the spring and sample clamp

a. Center the sample on the reference line

b. Be sure to push the sample in far enough that it is held firmly by the spring

3. Release the spring

(5) HTK1200N Furnace
Only SEF staff can mount the furnace onto the diffractometer. Users are allowed to load samples onto the sample holder, insert and remove the sample holder from the furnace. 

Samples can be mounted in furnace two ways. The bare sample holder is a platform with a 16mm diameter. A sample <20mm diameter and <3.5mm height can simply rest on top of this platform. Alternatively, there is a ceramic cup, 0.8mm deep and 14mm inner diameter, which can hold a sample or hold powder. 

To load the sample holder
1. If working with powder, then top-load the powder into the ceramic cup

a. Load the powder as densely as possible into the ceramic cup

b. Make sure the powder surface is flat, smooth, and level with the top of the cup

c. Make sure that there is no loose powder around the bottom edge of the cup

2. If working with solid pieces: 

a. you can put the piece into the ceramic cup if it fits

i. If the piece is thinner than 0.8mm, then the lip of the ceramic cup will be higher than the sample surface. In this case, the cup will block the X-ray beam at small incident angles

ii. If the sample is thicker than 3mm, then it cannot be put into the ceramic cup

b. If the piece does not fit into the ceramic cup, then just put it onto the ceramic pedestal. 

i. If the sample might react with the ceramic pedestal, then put an intermediate material between the pedestal and the sample (Pt foil, Al2O3 plate, etc)

3. Place the ceramic cup or sample, centered, on the ceramic pedestal
4. Carefully put the fixing ring around the sample and gently push downwards until it is securing the sample to the sample platform

a. The notch in the fixing ring goes over the thermocouple

b. The fixing ring does not snap into place, it is just snug enough to keep the ceramic cup from sliding off of the sample platform

c. The fixing ring is very fragile and very expensive; try not to break it

d. If the sample is not in the ceramic cup, then push the fixing ring gently into place on the pedestal

i. If the ring does not fit around the sample, or if the edge of the ring is too high, then you can try working with a sample without using the fixing ring

ii. You can try using vaseline, silicone grease, or other material to fix the sample in place
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Figure 5.13 Illustration of the sample holder for the furnace

To insert the sample holder into the furnace
1. Lift in the sample holder off of the support base

2. The sample holder is inserted through the opening in the bottom of the furnace

a. The safety post on the sample holder should be away from you and towards the goniometer
b. The two guideposts on the furnace fit into the holes in the center of the edge of the sample holder

3. Carefully slide the sample holder up into the furnace

a. If the sample holder catches on part of the furnace, then it is not being inserted straight. Lower it and try inserting it again.

4. Once the sample holder is fully inserted, tighten the four thumbscrews so that the sample holder is firmly held into the furnace.

a. Do not need to overtighten the screws; turn them so that they are snug 

5. Connect the thermocouple wire from the sample holder to the orange thermocouple wire in the enclosure

a. The thermocouple connectors just snap together

b. They do not screw together; DO NOT twist the thermocouple connectors or they will break
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6. On the front panel of the temperature control unit (the TCU1000)
a. Hit the on/off button to turn the power off

b. Hit the on/off button to turn the power back on

i. This clears any errors in the Eurotherm controller
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To remove the sample holder from the furnace
1. Disconnect the thermocouple wire from the sample holder from the orange thermocouple wire in the enclosure

2. While supporting the sample holder, unscrew the four screws

a. You actually only need to support the sample holder when loosening the last two screws

3. Carefully slide the sample holder down, out of the furnace

4. Put the sample holder on its support base, being careful not to twist or stress the thermocouple wire

(6) Oxford Systems Cryostat
VI. Collecting Data

This section will describe how to collect data using X’Pert Data Collector. The most common data collection strategy involves running a measurement program. The measurement program is written and saved without containing any information about the sample; this way, the same program can be used to collect data from many different samples. Alternatively, a simple scan command can be used to collect data without a pre-written program; this is called the manual scan. This section will describe how to collect data using these two different approaches. 

However, this section starts by describing the difference between relative and absolute scans. The relative and absolute scans are the foundation of the data collection strategy in Data Collector. 

6.1 Relative and Absolute Scans and their Scan Parameters
6.2 Writing a Measurement Program
6.3 Collecting Data using a Program 
6.4 Collecting Data using a Manual Scan
6.1 Relative and Absolute Scans and their Scan Parameters
Most data collection in Data Collector is collected as a Relative Scan or an Absolute Scan. Almost all other measurement strategies consist of a series of relative or absolute scans. 
In the absolute scan, the starting and ending positions of the scan are defined as absolute angles; for example, the scan will start at 20 °2Theta and end at 70 °2Theta. This is the way in which a diffraction scan is often defined for phase ID and other analyses.

In the relative scan, the scan is defined as a range around the current instrument position.  Relative scans can be initiated by using a Measurement Program (see section 6.2D below) or by using a Manual Scan (see section 6.4 below). The start and end positions of the scan are not explicitly defined. Instead, the scan is collected in a range centered on the current position of the instrument; for example, the relative scan might define data collection from -5 °2Theta to +5 °2Theta from the current detector position. The relative scan is often used for fast measurements around a central feature; for example, when aligning the sample or collecting the rocking curve of a peak. 

Figure 6.1, below, shows two examples of dialogue boxes for defining an absolute scan and a relative scan. The two scans differ only in the way that the scan range is defined. All other parameters are defined identically, including the “Scan Axis”, the scan mode, the “Step Size”, and the “Time per step”. These parameters are defined below. The “Number of steps” and “Total time” are not parameters that can be user-defined, but will be calculated as all other parameters are specified. 
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Figure 6.1 Windows for defining absolute scans (left) and relative scans (right)
A. The Scan Range

This is the one parameter that differs between the relative and absolute scan. 

Absolute Scan: The scan range is defined by the “Start angle” and the “End angle”. This specifies the starting and ending position of whatever axis is being scanned (as defined by the scan axis). 

When specifying the start angle, it must be below the end angle. If necessary, you should define the end angle first to avoid an error message. For example, referring to the figure 6.1, if you wanted a scan from 100 to 150 °2Theta, you could not change the “Start angle” to 100 because this would be larger than the current “End angle” 90 and would produce an error message. You would need to first change the “End angle” to 150, and then change the “Start angle” to 100. 

Relative Scan: The scan range is defined by the “Range”, which is the total distance that the scan axis will travel during data collection. The start and end angles are ±1/2(range), centered about the current position of the instrument. The position of the instrument may be defined in the Instrument Settings tab before running the program, or in the dialogue window that appears when you begin the data collection program (see section 6.3 below)
If you specify scan limits that are out-of-range, the scan is performed, but only measures within the allowed limits. For example, a relative scan with a 2Theta center point of 2° and a range of 10° (thus requesting a scan from -3° to +7°) will result (because of a lower Goniometer limit of  -1°) in a measurement between -1° and +7°.

B. The Scan Axis
The “Scan Axis” defines what will change as the data are collected. The available options depend in part on the sample stage that is used. All sample stages are capable of two-circle data collection, where the two circles are omega and 2theta. Omega is the incident angle, i.e the angle between the incident X-ray beam and the sample. 2theta is the diffraction angle, defined as the angle between the incident X-ray beam and the detector line of sight. There are five options for collecting data with these two circles. 

“Gonio”: this is the conventional scan for Bragg-Brentano geometry. The axes omega and 2theta are moved in a coupled manner so that omega is always ½ 2theta. 
“2Theta:Omega”: this is a variation of the conventional  scan. Both 2theta and omega are scanned. The scan range and scan rate are defined for 2theta; omega follows 2theta at ½ the scan rate. The difference between this and a gonio scan is that there can be an offset between 2theta and omega, so that omega= ½ 2Theta + offset. This is useful when collecting a diffraction scan from an epitaxial film, when the tilt of the film is compensated for by the offset.

“Omega:2Theta”: this is like the 2theta:omega scan, except that the scan range and the scan rate are defined for omega; 2theta moves coupled to omega at 2x the scan rate. Again, an offset can be defined between 2theta and omega.  

“2Theta”: only the detector is scanned as data are collected. All other axes, such as the incident angle omega, are fixed. This is used for collecting glancing incident angle diffraction patterns. 

“Omega”: only the omega axis is scanned as data are collected. All other axes, such as 2theta, are fixed at specific angles. This mode is used to collect rocking curves. 

If the OEC sample stage is mounted, there are two additional scan axes available:

“Phi”: phi is the rotation of the sample around the z axis (axis normal to the sample surface). Data can be collected as a function of phi as the sample rotates. All other angles, omega, 2theta, and psi, are defined and fixed.

“Psi”: psi is the tilt of the sample around the x axis (the axis formed by the projection of a line, from the X-ray tube to the detector, onto the plane of the sample). Data can be collected as a function of the tilt psi; all other angles, omega, 2theta, and phi, are fixed. 
C. Other Gonio angle

In an absolute scan, if the “Scan Axis” is “2Theta:Omega” or “Omega:2Theta”, then “Other gonio angle” allows the value offset between the omega and 2theta angles to be specified. 

If the “Scan Axis” is “2Theta”, then “Other gonio angle” allows the omega angle to be specified. If the “Scan Axis” is “Omega”, then “Other gonio angle” allows the 2theta angle to be specified. 

For each of these settings, you can choose “Use actual angle at start” or enter a specified value. The option “Use actual angle at start” will read the goniometer position from the Instrument Configuration (see section 5.2) before starting the scan and will use that value. Alternatively, you can define a specific value by selecting the “Other” button. 
D. Scan Mode 

The scan mode can be either step, continuous, or pre-set counts. The X’Celerator detector is best utilized in continuous mode. The point detector, with parallel-beam optics, can be used in any mode; however, the X’Pert Pro MPD is most often run in continuous mode.
“Step”: In a step scan, the diffractometer moves to various discrete positions before counting photons with the detector. Each data point corresponds to a single position of the diffractometer, and no information is recorded from the space in-between data points. A step scan takes more time than a continuous scan because of the time it takes to position the goniometer. 

“Continuous”: In a continuous scan, the diffractometer moves from start to end at a constant speed. All photons observed by the detector over a small range (the step size) are integrated into a single data point. The readout point is presumed to be at the center point of the interval. 

“Pre-set counts”: A pre-set count scan is a step scan where the detector runs until either the pre-set number of counts is reached or the maximum time is exceeded, whichever happens first. The measured number of counts and the counting time are stored. 
E. Step size

The “Step size” defines the frequency with which data points are recorded over the range of the scan. The ramifications of the step size depend somewhat on the scan mode. 

In a step scan, the “Step size” is the distance between successive data points. A larger step size results in faster data collection but lower angular resolution; whereas a small step size improves angular resolution but increases the data collection time. 

In a continuous scan, the “Step size” defines the interval over which observed photon counts are integrated into a single data point. A larger step size results in more counts per data point, which can produce a more intense signal, but a lower angular resolution. A small step size improves the angular resolution but produces less signal in each data point, therefore requiring a slower scan speed. 

F. Time per step or Scan Speed 

The “Time per step” or “Scan speed” are inherently related. Either can be defined for any type of scan; when one is set then the other will automatically be recalculated.

The “Time per step” defines how long the detector will observe each data point. In a step scan, this is the amount of time that the detector will count photons at each diffractometer position; in a continuous scan, this is how long the detector will spend moving over the interval range. It is most common to define this value when collecting a step scan or collecting a continuous scan using the X’Celerator detector. 
The “Scan speed” defines the rates at which the diffractometer moves during data collection. It is most common to define this value when collecting a continuous scan using the point detector.  
G. During Data Collection

While data are being collected, a real-time display will show the data. There are several things that you can do while data are being collected; most options are accessed by right-clicking on the scan display window
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To modify the view during data collection:

· right-click within the display window

· go to the Axes… menu

· Change the view options

· Click Close  
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You can pause or stop a scan during data collection:

1. Right-click within the scan display window

a. Select [image: image60.jpg]


 Hold or [image: image61.jpg]


 Stop
2. Or you can go to the top menu bar and click on the 
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3. The diffractometer will stop at its current position and give you an Options dialogue. 
a. The shutter will remain open until you choose an option
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4. You can choose to
a. Abort the scan
i. Data will be saved up to the point where you aborted the scan
ii. The diffractometer will move to its ‘park’ position and the shutter will close
b. Continue the scan 
i. The scan will resume from the point where you paused it
ii. The system will wait as long as you want it to until you choose to continue
6.2 Writing a Data Collection Program
Programs are used to collect data. They are written to control the instrument, independently of your sample. A single program can be used repeatedly to collect data from a wide variety of samples. You can write a data collection program at any point while Data Collector is running; before you have connected to the instrument, after you have connected to the instrument, while another scan is being collected, etc. 

A. Creating a Program

You can create a new program or you can open and modify an existing program. 

To create a new program

1. Go to File> New Program… 
2. Choose the type of program you want to create from the drop-down menu
3. Click OK
To open an existing program
1. Go to File> Open Program
2. Specify the type of program that you are looking for from the “List programs of type:” drop-down menu in the Open Program window
3. Select the program that you want from the database list

4. Click OK
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Each different program type has a different use and different parameters that you can define. Most share many of the parameters of an absolute or relative scan, as described above in section 6.1. Refer to that section for a description of the parameters scan axis, scan mode, range, step size, and scan speed/time per step. 

B. Defining the Configuration

In every scan, the “Configuration” can be defined. This refers to the instrument configuration file, as described in section 4.3. By default, when you create a program the “Configuration” will be set to the current configuration that you are using. For many types of programs, the configuration does not matter; for example, an absolute scan defined using the “OEC Motorized Platform” as its configuration can still be used to collect data when you have the Furnace sample stage on the diffractometer. The only time the configuration matters is if you create a scan program that is not possible for certain stages: for example, you cannot use a Non-ambient program to collect data from the Sample Changer sample stage; you cannot collect a scan with the phi axis if the sample stage is the Furnace, etc. 

C. Program Settings

All programs have a Settings option in common. If you click on the [image: image69.jpg]Settings...



 button in the Prepare Program window, a dialogue box will open that shows all of the instrument configurations for the Incident-Beam Optics and Diffracted-Beam Optics (section 5.2 above). 

By default, all values for these settings will be set to “Actual”. This means that they will use the values that you specified when configuring the instrument as described in section 5.2. There is one exception, however. 
If you are collecting data using the X’Celerator detector in scanning mode, then you must

1. go to [image: image70.jpg]Settings...




2. in the Program Settings window, select Detector in the Diffracted beam path

3. using the drop-down menu, shown below, change the value for Detector from “Actual” to “X’Celerator[2]”
4. Specify for parameters for the X’Celerator

a. “Scan mode”: Scanning

b. “Active Length”: a value from 0.518 to 2.122 °2Theta

5. Click OK
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 are also useful in that they can be used to change computer-controlled accessories for different scans. For example, the [image: image74.jpg]Settings...



 in the program could be used to specify that that program always uses a fixed irradiation length for the programmable divergence and anti-scatter slits (as described in section 5.2). The values specified in the Programs Settings always override the values that you configured in the Instrument Control panel in section 5.2. 
The following sections describe each different type of program, what it is used for, and how to define it. 

D. Relative Scan & Absolute Scan
The steps for creating a relative scan and an absolute scan are very similar. The difference between these two types of scans is described in section 6.1 above. Relative scans are defined as an angular range around the current instrument position; for example, from a position that has been reached using an optimize program. 
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All parameters in the Scan properties tab are described in section 6.1. If you are using the X’Celerator detector, you must change the Settings as described above in section C. 
Repetition

In the Repetition tab you can define the repetition mode. They are: “Single scan”, “Repeated scan” and “Wobbled scan”.
The “Single scan” is the most common mode: the scan is performed once and that is it. 

The “Repeated scan” mode allows the same scan to be repeated up to 999 times. Sometimes the data quality is better if you sum five 2-hour scans rather than collecting one 10 hour scan. All scans are saved in the same file; however, they are saved individually. The scans can be summed or averaged in another program, such as X’Pert HighScore Plus or Jade. 

[image: image77.jpg]& Prepare Relative Scan [Program6]

OEC HotoisdPaiom %

Toatin s




To configure a repeated scan:

1. Go to the Repetition tab

2. Select “Repeated Scan” from the drop-down menu

3. “Number of repeats” lets you specify the number of times the scan will be repeated

4. The total time in the Repetition tab indicates how long it will take to collect all scans. The total time in the Scan properties tab indicates the time for a single scan. 

The “Wobbled scan” mode allows the same scan to repeated several times with a slight change in the wobble axis between each scan. Therefore, unlike the repeated scan which collects several identical scans, the wobble scan collects several similar but slightly different scans. This can be advantageous for improving the particle statistics from a sample with large particle sizes, grain sizes, or texture. 
Each scan is saved as an individual data set in the same file. The scans can be summed or averaged in another program, such as X’Pert HighScore Plus or Jade.

To configure a wobbled scan:

1. Go to the Repetition tab

2. Select “Wobbled scan” from the drop-down menu

3. Specify the “Wobble Axis”
a. This is the axis that will be changed between each scan

b. Omega, phi, or psi may be chosen as the wobble axis

c. Omega cannot be chosen as the wobble axis if the scan axis is Gonio (see the error message in the figure below). 

d. The wobble axis cannot be the same as the principal scan axis

i. For example, a wobble axis omega is incompatible with a scan axis Omega or a scan axis Omega-2Theta. It would work with a scan axis 2Theta-Omega, however.

4. The “Number of steps” is the number of different scans that will be collected

5. “Step size” is the amount that the “Wobble Axis” will change in-between each scan 

6. The total time in the Repetition tab indicates how long it will take to collect all scans. The total time in the Scan properties tab indicates the time for a single scan. 
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E. 2-Axes measurement 

2-axes measurements consist of a series of relative scans made along axis 1 at regular intervals of axis 2. 

The figure below illustrates a series of forty-one 2Theta-Omega scans that will be collected as defined by the settings for Axis 1. Each 2Theta-Omega scan will be collected at a different offset for Omega, as defined by Axis 2. This example would produce a reciprocal space map in which the 2theta-omega scans are collected for different tilts along the omega axis of the sample.  
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“Axis 1” can be any scan axis available for relative scans, as described above in section 6.1. The scan properties for Axis 1 are defined as they would be for any relative scan. As with all relative scans, the scans are collected around the current instrument position, which might have been reached during a previous Optimize program. 

If you are using the X’Celerator detector, you must change the Settings as described above in section C.

“Axis 2” can be omega, 2theta, phi, or psi. Only the range and step size is defined for this axis. The step size indicates how much the Axis 2 will change in-between each scan of axis 1; the step size and range determine how many scans will be collected. 
Each scan is saved as an individual data set in the same file. The scans can be summed or averaged in another program, such as X’Pert HighScore Plus or Jade.

You can modify the range of the scan graphically on the reciprocal space map, if you use Omega, 2Theta, Omega-2Theta or 2Theta-Omega as the scan axes. See the subject “reciprocal space map” in the online help for Data Collector.
If you specify scan limits that are out-of-range, the scan is performed, but only measures within the allowed limits. For example, a relative scan with a 2Theta center point of 2° and a range of 10° (request a scan from -3° to +7°) will result (because of a lower Goniometer limit of  -1°) in a measurement between -1° and +7°.

F. Optimize program

Optimize programs are used to the condition for maximum intensity or the maximum of the first derivative of intensity. It is most often used to optimize the tilt of a sample or to compensate for compositional peak-shift in thin films for rocking curve analyses, but can be used as a precursor for many different types of scans. 

The optimized position of the diffractometer is retained in the instrument settings when the scan is finished. This position can subsequently be used by a stationary measurement, relative scan, 2-axes measurement or another optimize program as the center position. An automated optimization strategy can be created by using a general batch program comprising various optimize program steps followed by a final measurement step. 

The data from an optimize program are not saved automatically. They can be saved, once the scan is completed, by going to File> Save. 

All Optimize Programs execute a relative scan or series of relative scans that use the typical scan parameters of “Range”, “Step size”, “Time per step”, and “Scan speed”, as described in section 6.1.
If you are using the X’Celerator detector, you must change the Settings as described in section C. 
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“Optimize Mode”
The “Optimize Mode” determines what will be optimized and how, as detailed in the table below. 
“Stop at level”, “Go to maximum” or “Go to maximum of first derivative” are single axis modes that will perform a single relative scan of the scan axis, and then optimize by the option chosen. 
“Optimize Phi” or “Optimize Psi” are 2-axes modes: a series of scans along the scan axis will be collected, each with a slight variation in the 2nd axis (phi or psi). The value of phi or psi that produced the best scan will be chosen as the optimum value. 

	Stop at level


	A relative scan in continuous mode is made on the defined scan axis until the entered intensity value is reached. This mode is often used as a first step in the total optimization process. 

The “Stop level” is the intensity that must be observed for the optimize program to finish.

· If the Stop level is not reached the program will set the position of the scan axis to its original value and then give an error message, “Stop level has not been reached”. You must confirm this message by pressing OK. 

· If you are not absolutely sure that the stop level will be reached, then do not use the “Stop at level” mode in a batch program. You should choose the stop level at a minimal value to ensure that it is reached. On the other hand, the stop level should be large enough that the program does not optimize on a satellite peak or fringe.

· The 2nd axis parameters are not used in this mode.



	Go to maximum
	A relative scan in continuous mode is made on the defined scan axis. After completion, the position of the maximum intensity is determined by a seven point parabolic fit. The position on the scan axis is then set to the calculated maximum.

· The scan range must encompass at least 7 data points

· The Stop level and 2nd axis parameters are not used in this mode.



	Go to maximum of first derivative
	A relative scan in continuous mode is made on the defined scan axis. After completion, the first derivative of the scan is determined, inverted, and displayed in a different color. The position of the maximum of the inverted first derivative is then determined by a seven point parabolic fit. The position on the scan axis is then set to the calculated maximum. 

· The scan range must encompass at least 7 scan points

· The initial intensity is assumed to be high

· The Stop level and 2nd axis parameters are not used in this mode.

· This mode is useful for sample alignment purposes, such as scanning in psi. 



	Optimize Phi
	A series of at least 7 short relative scans in continuous mode executed on the defined scan axis at a number of evenly spaced Phi positions. The values of all the scan maxima are used to calculate the Phi maximum using a seven point parabolic fit. The Phi angle is set at this calculated maximum value. 

· The 2nd axis Phi parameters are used to define the Range of phi that will be examined, and the change in Phi between each successive relative scan (Step size).

· In order to optimize Phi use asymmetric reflections (Omega  2Theta/2)



	Optimize Psi
	A series of at least 7 short relative scans in continuous mode executed on the defined scan axis at a number of evenly spaced Psi positions. The values of all the scan maxima are used to calculate the Psi maximum using a seven point parabolic fit. The Psi angle is set at this calculated maximum value.

· The 2nd axis Psi parameters are used to define the Range of psi that will be examined, and the change in psi between each successive relative scan (Step size).

· In order to optimize Psi use symmetric reflections.




If the fitting parabola cannot be fitted because no maximum is found, the program moves the goniometer or sample stage axis to the end of the range which has the highest intensity.

 

G. Stationary measurement

A stationary measurement is performed with a point detector or an X'Celerator detector in receiving slit mode. The result is a single measured point. This is most often used to measure the intensity of the direct X-ray beam during sample alignment. 

The X'Celerator detector cannot be used in scanning static mode for this measurement. 

A stationary scan can be run in two modes: 

· “Pre-set time” will count photons at a specific diffractometer angle for whatever the value “Time (s):” is. 

· “Pre-set counts” will count photons until the detector has observed the number of photons equal to “Pre-set counts”. 

In the “Position” fields you can either use the actual positions of the diffractometer at the start of the program, you can enter absolute values for any/all of the diffractometer positions, or you can link to Unit Cells & Miller Indices (see help for more details) to allow X'Pert Data Collector to calculate the values for you. 
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While executing a stationary measurement the Scan Window consists of two parts. The vertical bar on the right hand side shows the accumulated counts, or current count rate depending on the preferences defined in the Axes dialogue. When the measurement is finished, the measured intensity is indicated by a cross in the left-hand part of the Scan Window. 

H. Q scan

A Q-scan is defined as a straight line in reciprocal space and is performed as a relative step scan around the current Omega and 2Theta positions. Q-scans are measured in reciprocal lattice units (rlu). The steps of the goniometer axes (Omega and 2Theta) are chosen to achieve a constant step size in rlu. 

Read the online help in Data Collect on Q scans and Reciprocal Space Maps for more information. 

I. Stress measurement

A stress measurement is a series of absolute scans measured at various tilt positions (in either Omega or Psi) and one or several Phi positions. By measuring the shift in peak position as a function of the tilt of omega or psi, the residual stress in a sample can be calculated. 

Each scan is saved as an individual data set in the same file. The scans can be analyzed in another program, such as X’Pert Stress or Jade.

If you are using the X’Celerator detector, you must change the Settings as described in section C. You should define your settings before you define the rest of the parameters or change the scan table, because changing the settings redefines the scan table and therefore undoes all the changes you have just made to it.
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Parameters that you must define in the stress program include:

“Tilt axis” 

The tilt axis can be omega or psi. Both axes can be used for conventional “sin2 psi” analysis: in residual stress analysis the tilt angle or inclination of the reflecting planes with respect to the sample surface is historically called "Psi", regardless of whether the tilt axis is actually omega or psi. 

Using Omega or Psi as the tilt axis is mostly related to sample type, sample shape, and the functionality of the sample stage (eg can the sample stage tilt in psi?). Refer to the Data Collector on-line help topic “Measurement Strategies for Stress Measurements”.
“Tilt range”
The preparation of the stress scans is done by entering the tilt range parameters. 
The tilt range modes can be: “Only positive”, “Pseudo positive + negative”, “Positive + negative”, “Positive + Pseudo negative”, and “Only negative”. 
· “Positive + negative” is the normal choice when combining:

· Tilt axis Psi and focusing optics

· Tilt axis Omega and parallel-beam optics

· Tilt axis omega or psi and programmable slits set to automatic mode (see section 5.2D) 
· “Only positive” or “Only negative” can be used with the above configurations as well. They only collect half the scan as the “Positive+negative” mode, and are used when a complete stress analysis is not feasible due to time or is not required because there is no shear stress.

· “Positive + Pseudo negative” is the choice for an Omega tilt axis using focusing optics or using fixed slits, because it avoids large defocusing effects and is less sensitive to alignment errors. 
· If “Omega” is chosen as the tilt axis and “2Theta” as the scan axis then two extra tilt modes become available:

· “Omega derived only negative” and “Omega der. neg. + pseudo pos.”
· These modes can be combined with a glancing angle of incidence to facilitate analysis of thin films or small penetration depths

· Multiple reflections must be specified in the tab Scan positions
Pseudo positive/negative tilting is achieved by rotating phi by 180° and then applying a negative/positive tilt. For example, the scans are measured with a positive tilt; then the sample is rotated 180° and the scans are measured with a tilt in the same direction—only now this produces a pseudo-negative tilt. If the sample stage cannot rotate phi, pseudo positive and pseudo negative tilts are not possible. 

The field “Tilt limit –max. Tilt” describes how close you are willing to approach the physical tilt limit of the diffractometer. This effectively determines the tilt range. The maximum tilt is determined by the diffractometer limits and by the diffraction angle of the peak that you are observing. The tilt limit depends on how much defocusing you are willing to accept during data collection. When you use focusing optics we advise you to choose at least 15° for this distance; with parallel-beam optics the distance can be as small as 5°.

The field “Sin2Tilt step size” determines the total number of scans within the Tilt range. We advise you to choose the Sin2Tilt step size not larger than 0.1; a value of 0.05 or 0.025 is typical. 
The combination of these two parameters, “Tilt limit – max. Tilt” and “Sin2Tilt step size”, will determine the number of tilt steps, and therefore the number of scans, for each diffraction peak (as specified by the “Scan Position”).

“Phi Steps”
The “No. of Phi steps” determines the number of rotational directions in which the stress is measured. A “No. of Phi step” of 1 would only measure the stress in a single direction within the plane of the sample; this is appropriate only for isotropic stresses. Measuring the stress at addition rotations of the sample allows uniaxial and biaxial stresses to be quantified.
The maximum “No. of Phi steps” is 36. The distance between subsequent phi positions is 180/n. The chart below lists the phi positions for some common “No. of Phi steps”. 
	 No. of Phi steps
	Phi positions (°)

	1 
	0

	2 
	0, 90 

	3 
	0, 60, 120

	4 
	0, 45, 90, 135 

	n (5 to 36) 
	Phi step = 180/n 


 

If the sample stage cannot rotate phi, then Phi steps are not possible. 

Scan Axis
The options for “Scan Axis” are gonio, 2Theta, and 2Theta-omega. 

· When the tilt axis is “Omega”, the scan axis is normally "2Theta-Omega"
· When the tilt axis is “Psi”, the scan axis is normally "Gonio". 

Other Gonio Angle 

In the “Other gonio angle” frame you can press the “Use actual angle at start” option button to copy the actual goniometer angles of the instrument at the start of the measurement. Alternatively, you can define a specific value by selecting the “Offset” option. This option is useful when working at glancing incidence for the analysis of thin films or a small penetration depth. The other goniometer angle depends on the scan axis:

· If the scan axis is “2Theta”, the other goniometer angle will be Omega, 
· If you are using a linear detector in static mode and the scan axis is “2Theta”, then the other goniometer angle will be the offset instead. 
· If the scan axis is “2Theta-Omega”, the other goniometer angle will be the offset 
· The offset is the angle between ½*(2Theta) and Omega. 

Scan Parameters 

The typical relative scan parameters of “scan mode”, “scan range”, “step size”, “time per step”, and “scan speed” are defined or calculated in this field, as described in section 6.1. The step size should be selected to measure the complete peak with at least 10 points on the full width at half maximum. 

Scan Positions 

The “Scan Positions” table defines the central position of the relative scan(s) used for the stress measurements. Each scan position should be centered on a peak that will be used for stress analysis. Either a single scan position can be defined or a series of scan positions can be defined, enabling multiple hkl reflections to be measured. 

The “Scan Positions” table can be edited using the normal grid functions (Cut, Copy, Paste) for single rows, as well as a [image: image83.jpg]Delete selected row



 button.

The diffraction peaks used for analysis should be high angle peaks, particularly for an Omega stress measurement. The peak should not be overlapped by any other peaks. 

In the Current Scan Table frame, the number of scans that will be collected and the total measurement time are calculated and displayed.
Current Scan Table

To view and/or change one or more scans in the scan table press [image: image84.jpg]


 to open the Modify Scan Table Stress Program window.  This window contains a grid that lists the Number, Tilt, Sin2Tilt, Phi and so on, of each scan that will be collected in the stress measurement. The grid is initially generated from the program parameters that were specified in the Prepare Stress Measurement window. In the scan table, you can change Psi, Phi, 2Theta Start and End, the step size, measurement time, and so on for each of the scans in order to optimize them. 
After you have edited the scan table, you should not change any of the tilt range parameters or scan parameters in the Prepare Stress Measurement window, because this causes the entire scan table to be overwritten with the new parameter values.
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J. Texture measurements

Texture measurements are used to determine the distribution of intensity for a peak (hkl) as a function of the sample tilt and rotation. Multiple data sets will be collected and saved in a single file. This file can then be read by a program such as X’Pert Texture for analysis.
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“Measurement type” determines if the Texture program will measure: 

	Single Pole Figure Measurement
	The pole figure measurement executes a series of Phi (rotation) scans at regularly spaced Psi (tilt) positions for a specific diffraction peak. 

	Background Measurement
	These data are used to correct for background during quantitative pole figure analysis. Background measurements can be performed on the same sample that the pole figure was made on.

	Single Defocusing Measurement
	These data are used to correct for the defocusing effect in pole figure data. The defocusing effect results because when the inclination of the sample increases, the peaks in the diffraction pattern are broadened. The defocusing measurement should be collected using a texture free sample (such as a powder) with the same composition as the sample of interest. If such a sample does not exist, defocusing corrections can be estimated from the measured data (this is not done in X'Pert Data Collector, but, for example: in the X’Pert Texture program). 


The background and defocusing correction measurements for a texture analysis must be performed with the same optical parameters as the texture measurements. The values for the collimators and masks are rounded to multiples of 0.1 mm in the export formats for all types of texture measurements. 

“Positions”
The 2Theta position(s) for the texture measurements are defined in two possible ways: 

· “Use actual 2Theta angle at start” The actual 2Theta angle of the goniometer when the program starts is used for the measurement. This is useful after execution of an Optimize Program (section F above) when peak positions differ from sample to sample. It is also possible to combine an optimize program with texture measurements in a General Batch program (section K below). 
· “2Theta (°)”: Alternatively a specific 2Theta position can be specified in the texture program. 
· For background measurements, one or two 2Theta positions are defined using “Background offset” value(s) with respect to the chosen 2Theta value (2Theta position = 2Theta value + offset). A negative offset will measure the background at a below the specified 2Theta, and the positive offset will measure the backgroud above. 
· The parameter “hkl for ODF" defines the measured crystal plane for any subsequent Orientation Distribution Function (ODF) calculation in a texture analysis module like X’Pert Texture. It is a used only for documentation.

Use the Edit button to define the parameters for the selected measurement. [image: image87.png]@ Prepare Pole figure
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Each scan is collected as a Phi scan using the standard absolute scan parameters “Start angle”, “End angle”, “Step size”, and “Time per step”, as defined in section 6.1.
Each phi scan is collected at a different tilt psi. The psi parameters define the “Start angle”, “End angle”, and “Step size” of the psi tilt axis in between each scan. 

All scans are saved in a single file.

If you are using the X’Celerator detector, you must change the Settings as described in section C. An X’Celerator detector can only be used in Receiving Slit Mode during a texture measurement. 

K. General batch

General batch programs consist of a list of items such as measurement programs, settings or timer statements that are executed sequentially. The General Batch is not tailored for a special purpose like the sample (changer) batch program or the non-ambient program, but instead is designed to be very flexible. 

When you begin to create a batch program, the grid in the Prepare Batch window is empty. The “Configuration” is automatically set to the current configuration of the diffractometer; it cannot be changed like in other programs. The upper right corner indicates the total time that the entire batch will take to execute. 

The first thing to do when creating a General Batch program is to uncheck the field “Define file names with measurements”. 
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There are three insert buttons that allow you to add items to the batch.

(1) Insert Measurement Program
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· After you click on Insert Measurement Program, the Measurement Program Step window will open

· This allows you to insert a saved measurement program into the batch. 
· Before creating the general batch, you must create and save the measurement program(s) that you will use in the general batch

· This program can be anything except another General Batch, Sample Changer, or Non-ambient program.

· Click Browse to look through the database of programs to find the one that you want to insert

· You can add a “Description” of the program step if you like.

· You will only be able to specify the “File Name” and “Sample” parameters if you did not uncheck “Define file names with measurements” as instructed above.

· You may find this useful and may want to leave that option checked and fill out this information when building the General Batch. I find it a big bother. 

(2) Insert Timer Settings
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This lets you make the instrument wait a defined time between steps. It is most often used to allow a sample to soak at the furnace temperature before collecting data, but could also be used if you were watching a sample dry or react with air or something.
(3) Insert Batch Settings

Batch settings allow you to make a number of changes to the instrument. This includes changing the temperature of a furnace, changing the sample from a sample changer, etc. 

You will only be able to change options that are permitted by the current configuration. Other options will be greyed-out.

Many options allow you to specify either an absolute value or an increment:

· “Set” lets you specify the absolute value to change a parameter to.

· “Increment” lets you change the parameter by a defined amount. This is especially useful if you are going to be using cut&paste or cycle functionality in the General Batch grid (described below). 
The functions available in the different tabs are:

Position 

Lets you change the current goniometer position of 2Theta, Offset, Omega, Phi, and/or Psi. Check the box next to the axis/axes that you want to change. You can drive the axis to a set position or change it by an increment.
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Sample Changer

Lets you change what sample is loaded from the sample changer magazine. Check the “Sample position” box to enable control of this parameter. 
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Sample Stage
You can control several different parameters, including:

· Sample Mode

· Lets you change the sample mode between powder and single crystal

· This is useful for some measurements of thin films on single crystal substrates

· Non-Ambient

· Lets you change the temperature of the furnace or cryostat. 

· In addition to specifying the temperature or temperature change increment, you should specify the heating rate “Slope (°C/min)”. 

· Do not check “Maximum Slope”.
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Sample Offset

This option lets you set or clear sample offsets.
· This is useful if you want to redefine the instrument axes after an optimization measurement or if you want to make sure that know sample offsets are applied from a previous measurement.

· Specify the axis that you want to redefine and what value it should be redefined as. The sample offset will be changed to allow the axis to be redefined thus. 
X-ray/PHD

Lets you change the generator power. This is most useful to turn the generator power down or off when the general batch is finished running.

· Check Switch if you want to turn the generator on or off

· Check Set if you want to change the generator power without turning it off.

Do not use this tab to set PHD levels. 
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File Names

You can choose to define file names within a batch program and/or at the moment of starting the general batch program. Use the File Name Settings button to choose the items you want incorporated in the XRDML file name. You can press the List of File Names button to obtain a list of the currently generated file names for inspection. 

Working with the General Batch Grid

As you build your batch, the procession of steps is recorded in a grid; each program item is recorded in a separate row. 
To select a program item, you highlight its row by clicking on the left-most column (the gray column to the left of the “Number” column, as illustrated below where row number 9 is being selected). Multiple items can be selected by holding down the shift or control key as you click on their respective rows. 

A selected program item can be modified either by double-clicking on a row in the grid, or by highlighting it and pressing the Modify button. 

You can use the Delete button to delete selected batch program items from the list.  

For easy editing, you can cut, copy, and paste items within the grid. Select the row(s), then cut or copy by using the icons in the toolbar or by using the standard MS Windows shortcuts, ctrl+x and ctrl+c. 
To insert a row, highlight a row on the grid. You can paste a cut/copied row, or you can choose an insert option. The new row will be inserted before the one that you highlighted.
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Using copy and paste of multiple rows, when combined with using increment changes in the Insert Batch Settings, is a good way to build a complete batch. For example, you could copy two rows, one that increases the furnace temperature by a 50°C increment and another that collects a scan. By pasting these two rows multiple times, you could build a general batch that will collect data at many different temperatures. 
You can also use [image: image97.jpg]


 to build a repetitive procedure of steps. Highlight the rows of items that you want to include in a repetitive cycle. Click on the [image: image98.jpg]


 button to display the Cycles window. In the Cycles window, you can specify how many times the group of actions will be repeated. 
Pressing Check causes the system to simulate the execution of the batch program that you just created. This is a good way to check a) if the program is correct and b) if it will run without manual intervention (for example: a specific step may require a filter inserting). These steps and any assumptions the system makes will be displayed in a message window.  

· The check functionality does not extend to the consequences of the goniometer resolution setting. 

· The check functionality may ask the same questions more than once. 

· The check functionality does not take the status of the active configuration into consideration.

· The check functionality does not cover the range check for the wobble axis for wobbled scans in relative or absolute scan programs. 
L. Sample (changer) batch

The Sample (Changer) Batch program is tailored to measure multiple samples using the sample changer/spinner. This batch allows you to specify the sequence in which samples are measured, the program used to measure them and the positions at the start of the measurement program step. The actual measurement programs, such as absolute or relative scans, must be created and saved before creating the Sample (Changer) Batch. 
In the Prepare Sample (Changer) Batch Program window, a grid is shown with the current list of measurements and samples to be run. Each individual step is recorded in a separate row. To select an entry in the grid, you highlight its row by clicking on the left-most column in that row (the gray column to the left of the “Number” column). You can select multiple lines by holding the shift or ctrl keys while you click on the lines. 
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To create a new entry in the grid, select a row and then click Insert; this will create a new step before the one highlighted. To change an entry in the grid, either double-click on the entry or select its row and click Modify. The Sample (Changer) Program Step window will open, allowing you to create or change a measurement step. 

In the Sample (Changer) Program Step window, you can select a previously saved measurement program to use by clicking on Browse and selecting it from the database. The sample parameter “Position” designates what sample from the changer will be loaded into the sample holder/spinner for the measurement. 
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In the absolute scan, in addition to specifying whether or not the X’Celerator detector is used in the Settings (see section 5.3C above), you can also specify whether or not the sample is to be spun in the sample stage section of the Settings window. 
Like the general batch, you can specify the file name and description while writing this program by checking the “Define file names with measurements” check box in the File name settings tab. It is highly recommended that you do not do this (uncheck the box), but rather specify the file names and descriptions when you run the measurement program. 

You can easily edit the grid by using cut, copy, and paste functions; use either the buttons in the toolbar, the entries in the Edit menu, or the typical windows shortcuts of ctrl+x, ctrl+c, and ctrl+v to cut, copy, and paste.
You can use the Delete button to delete selected batch program items from the list.  

The Sort button causes the batch to reorganize the grid by common sample positions in order to optimize the total measurement time by reducing the number of loading/unloading steps. 

The Check button causes the system to simulate the execution of the sample (changer) batch that you just created. This is a good way to check a) if the batch is correct and b) if the batch will run without manual intervention (for example: a specific step may require inserting a filter). These steps and any assumptions the system makes will be displayed in a message window. Since the program does not have exact information about the status of the instrument you might see a trivial message to mount a diffractometer part. 
· The check functionality may ask the same questions more than once. 

· The check functionality does not take the status of the active configuration into consideration.

· The check functionality does not cover the range check for the wobble axis for wobbled scans in relative or absolute scan programs. 

In the X-ray settings tab, you can instruct the diffractometer to change the generator power or turn off the generator when the Sample Changer batch is finished. This is very useful, and highly recommended, to conserve X-ray tube life (by not leaving the tube on at full power when it is not in use). 
The configuration is determined by the current configuration of the diffractometer and cannot be changed. 

M. Non-ambient program

Non-ambient programs are batch programs tailored for non-ambient measurements using the Anton Paar HTK 1200N furnace or the Oxford Cryosystems PheniX Cryostat during a measurement. You can use temperature settings, wait periods and measurement programs sequentially as required by the analysis being performed. These are displayed in the grid. 
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Each non-ambient program has at least 3 non-ambient steps which are automatically inserted by X'Pert Data Collector. These are: 

· The "start" non-ambient step. This step is used to bring the sample stage to the required start condition. 

· The "reset" step that concludes each iteration of a cycle. This step is used to bring the sample stage back to the start condition at the end of each iteration. The temperature in this step is equal to the temperature in the start step. 

· The “finish” non-ambient step. This step is used to bring the sample stage to the required end condition. 

You can change the start and end conditions but not the iteration end (reset) condition as this is always defined as being equal to the start condition. X'Pert Data Collector always proposes and enters the room temperature as default values for these three steps. 
The grid displays the item numbers and program items defined. Using Insert you can add a Measurement Program, Non-ambient Setting, or Timer Setting items. This will add a new entry into the grid before the line that you selected. You can only insert a step between the start step and the iteration end condition. 

To select an entry in the grid, you highlight its row by clicking on the left-most column in that row (the gray column to the left of the “Number” column). You can select multiple lines by holding the shift or ctrl keys while you click on the lines. You can easily edit the grid by using cut, copy, and paste functions; use either the buttons in the toolbar, the entries in the Edit menu, or the typical windows shortcuts of ctrl+x, ctrl+c, and ctrl+v to cut, copy, and paste.

The Non-ambient Program is by default a step-profiled scan. The furnace/cryostat changes the temperature to the desired value, stops at that temperature while measurements are collected, and then moves to the next temperature. This program is not designed to collect data while the temperature is changing. There are ways to accomplish measurements during a ramp; talk to SEF staff if you require this type of measurement.

When you Insert: Measurement Program, the Non-ambient Program Step window will open. You can use this dialogue to select a previously saved measurement program, such as an Optimize or Absolute Scan. Click on Browse to bring up a window allowing you to select the measurement program that you want.  The program that you select must have all appropriate settings specified in that program; for example, if it is using an X’Celerator detector (see section C). 
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If you opted to define file names and sample descriptions in the program (not recommended, see note below), you can enter those values in this window. 

You can also specify the starting position of the goniometer, which is useful when you are executing a Relative Scan. 

The Priority section allows you to determine what is more important: completing the entire measurement or not dwelling at a given temperature for more than a certain amount of time. If you select “Measurement time” as your priority, the scan measurement will stop at the designated time, whether or not it has finished. 
When you Insert: Non-ambient setting, the Non-ambient Setting window opens. This allows you to designate a target temperature and the ramp rate (i.e. Slope). 

When collecting data at evenly spaced temperature intervals, the increment option is very useful. You can indicate that the temperature should change by a set increment (ex +100°C), and then repeat this command. The grid above shows an example of alternating measurements and incremental temperature changes. This grid was quickly created by copying and pasting the two step process several times. 
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The “Use Maximum Slope” option tells the computer to change the temperature at the maximum rate allowed by the controller of the current sample stage. More typically, you will designate the ramp rate:
· Uncheck “Use Maximum Slope”
· Enter a value for “Slope” to designate the ramp rate

· The Time will be calculated to tell you how long the ramp will take

The maximum and minimum slope values for the two non-ambient stages are:
· Anton Paar HTK 1200N furnace

· Maximum temperature= 1200°C

· Minimum temperature= 25°C

· Maximum Slope= 60°C/min

· Typical ramp rates= 10 to 30°C/min

· Oxford Cryosystems PheniX cyrostat

· Maximum temperature= 310 K
· Minimum temperature= 11 K

· Maximum slope= 360 K/hr (60 K/min)

· Minimum slope= 1 K/hr (0.017 K/min)

· Typical ramp rate= 120 K/hr (20 K/min)
When you Insert: Timer setting the Timer Setting window will open. This allows you to program a pause into the non-ambient batch. Most often this is used after a temperature ramp to allow the sample to soak at temperature before collecting data; for example, to make sure that the sample is at equilibrium or to minimize any temperature gradients. 

· “Wait for (h:m:s):” allows a definite time to be defined for the wait period. This is the most often used option for a wait.

· “Wait until data & time” will cause the non-ambient batch to pause until the designated day and time. Obviously, the inclusion of such a setting means that the non-ambient batch cannot be reused for other measurements at a later date. 
[image: image104.png]") Timer Setting,
© Wat o s} 00000

Wit uni date (demmyy):

time ()





To change an entry in the grid, either select it and click Modify or double-click on the entry. 

In the Cycle/File name settings tab you can tell the program to repeat the non-ambient batch for a given number of cycles. Any cycles that you define here are applied to the complete program; unlike the General Batch (section K) it is not possible to define a cycle for only a part of a program. 

Like the general batch, you can specify the file name and description while writing this program by checking the “Define file names with measurements” check box in the File name settings tab. It is highly recommended that you do not do this (uncheck the box), but rather specify the file names and descriptions when you run the measurement program. 

In the X-ray settings tab, you can instruct the diffractometer to change the generator power or turn off the generator when the Sample Changer batch is finished. This is very useful, and highly recommended, to conserve X-ray tube life (by not leaving the tube on at full power when it is not in use). 

The Profile button opens the Temperature Profile window. This window always exists in the background while creating the non-ambient batch; you can also access it by selecting the window on the desktop. The Temperature Profile window shows the time-temperature profile of the program. A Blue line segment in the plot indicate a period when no diffraction data are being collected (ramps, soaks, etc), while a yellow line segment indicates the collection of a diffraction pattern. During data collection, the actual temperature as function of time is recorded against this programmed profile. 
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The Check button causes the system to simulate the execution of the sample (changer) batch that you just created. This is a good way to check a) if the batch is correct and b) if the batch will run without manual intervention (for example: a specific step may require inserting a filter). These steps and any assumptions the system makes will be displayed in a message window. Since the program does not have exact information about the status of the instrument you might see a trivial message to mount a diffractometer part. 
· The check functionality may ask the same questions more than once. 

· The check functionality does not take the status of the active configuration into consideration.

· The check functionality does not cover the range check for the wobble axis for wobbled scans in relative or absolute scan programs. 

6.3 Running a Measurement Program
A. Starting the Run

To run a measurement program that you have created:
1. go to Measure > Program.
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2. An Open Program window will appear

a. Specify the type of program you want to use in the “List programs of type:” drop-down menu.
b. Select the measurement program that you want to run from the list and click OK
i. The last program that was used or saved will automatically be highlighted in the Open Program list.
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3. The Start window will open, in which you can specify the filename, sample description, and certain other parameters. 

a. The Start window will appear differently depending on what type of program you are running. See section B, below, for more details.
4. Complete the entries in the Start window, and then press OK
a. The enclosure doors will lock and the measurement program will be executed

i. If the doors fail to lock, the program will not run and an error message will appear on the computer. 

ii. Make sure the doors are closed completely and try running the program again

iii. If this does not work, contact SEF staff for help

b. Data will automatically be displayed in real-time in a scan window

c. Data are automatically saved every 5 minutes and at the end of the scan

d. When the scan finishes, the shutter will close and the enclosure doors will unlock.
5. You have now collected the data. 
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While data are being collected, a real-time display will show the data. There are several things that you can do while data are being collected; most options are accessed by right-clicking on the scan display window. These include changing the axes scale, pausing or aborting the scan, and other actions described in section 6.1G.
B. Defining Filenames
The Start window, where you define the filename(s) for a measurement, will appear differently if you are running a single-file scan or a batch of scans that will produce multiple files. 

(1) Single-File Scans

Single-file scans include any measurement that is saved into a single file. This includes scans with a single diffraction scan, such as Relative Scans, Absolute Scans, and Stationary Scans; and it includes multiple scans when they are all saved in a single file, such as Stress measurements, 2-Axes measurements, and Optimize Programs. 
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The parameters that you specify for this scan include:

File

· “Name”: the filename for the data file

· The default filename is a derivation of the program name

· The filename must be MS Windows legal. 

· Do not use illegal characters such as / \ ? : * “ < > |  % $ #

· “Folder”: the folder where the data will be saved.

· You can enter in the folder path

· Or you can click on the [image: image111.jpg]


 icon and navigate to the folder location

· “Comment”: this field is an optional page of description

· It will only be visible if you look into the raw data file text

· Sample description text, which will be visible in the header of data analysis software, should be entered in the “ID” field, not the “Comment” field.

Sample

· “ID”: the is a description of the sample and measurement which will be displayed in header or legend of data analysis software and reports
· It can contain any characters and be one line long

· “Name”: an optional sample designation that is not used by very many software packages

· “Prepared by”: optional field useful for tracking the person who created the sample or the data

· “Name” and “Prepared by” fields are typically used in an industrial setting for QC tracking

· They might be useful for your laboratory tracking too

Position

· Many measurement programs let you designate the position of the diffractometer at the start of the measurement

· This is particularly useful for 2-axes, Optimize, and Relative Scans

· Some positions cannot be changed at this point, such as the 2Theta position for an absolute scan (because the measurement program itself dictates the 2Theta position)

· Positions that you cannot change will be grayed out

· In single crystal mode (for users examining epitaxial thin films, see help for more information), you can use the Reflection parameter to specify the starting position for some scans like Relative Scan, 2-Axes measurement, or Optimize, 

(2) Batch Scans
Batch scans typically create multiple files containing several data sets. The Start window for batch scans has a File Name Settings button that is designed to facilitate the naming of the multiple data files that will be produced by the batch measurement programs. Programs that use this format include General Batch, Sample (Changer) Batch, and Non-ambient Batch programs.
The grid in the Start window will show each scan that will be collected and saved, and the Sample ID and File Name for that scan.
In the Start window you can designate the “File name” and “ID” for each sample individually by selecting the scan in the grid, and then entering the values in the File name tab. If many files will be generated, this can be a time consuming process. Automated options for naming files are described below.
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Fig Start windows for General Batch (left) and Sample (changer) Batch (right)
In a Sample (changer) batch you can go to the Sample ID tab and enter in a description for the sample in each position of the sample changer (see below). Those sample descriptions will automatically be used for the “ID” and “File name” of every scan; with the appropriate Sample ID corresponding to the sample position. Other batches do not have this option.
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To automatically generate a list of filenames (rather than manually designating each one), click on File Name Settings. This will open the Batch File Name Settings window, which contains tools to help you automatically generate a unique filename for every scan. 

The pictures below show the Batch File Name Settings windows for general batch, sample (changer) batch, and non-ambient batch programs. They share most features in common, with only one or two slight differences.
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Fig Batch File Name Settings windows for General Bach (top left), Sample (changer) Batch (top right), and Non-ambient Batch (bottom). 
In the Batch File Name Settings window, the top section allows you to generate sequential suffixes/prefixes for the data files that you generate. Options may include:

· “Use the item number in the file name”
· Appends the sequential item number, as _I#, from the batch grid into the filename

· Useful when combined with temperature for a non-ambient scan to distinguish between heating and cooling scans collected at the same temperature (for example)

· Useful for distinguishing between different scans of the same sample in a sample (changer) batch 

· “Use the cycle indicator in the file name”
· Appends the cycle number as _C# to the file name

· Only useful if you are using the cycle option in a batch

· Automatically appended in sample (changer) batches; there is no way  to remove

· “Use the start date in the file name”
· Generally will not distinguish one data set from another within the same batch

· useful when rerunning the same batch for many different samples on different days

· “Use the temperature in the file name”
· Appends the average temperature during data collection to the file name as _temp°C. 

· Only an option for non-ambient scans

· Extremely useful and highly recommended

You can check any combination of these options to generate the file name. 

The middle section of the Batch File Name Settings window let you designate prefixes/suffixes for all data sets, are well as where they are saved. 

· “Use same folder for all measurements”
· Allows you to designate where data will be saved

· You can either type in the path or click on the [image: image119.jpg]


 icon to browse to the path

· “Use batch file name prefix in the file name”
· Check this and enter a name into the field. The name you enter will be used as a common prefix for all data files generated by the batch

· If you do not check this, the files will inherit a prefix derived from the program name

· If you do not want any prefix, you should check this option but have a blank entry for the prefix

· “Use batch file name suffix in the file name”
· Allows you to generate a common suffix for all data files generated by the batch

· Unchecking this will produce no suffix in the file name

· “Generate unique file names when executing the batch”
· Ensures that no filename will duplicate another, therefore preventing one data set from overwriting another

· If a non-unique filename is generated, a sequential number will be appended to the end of the filename to make it different

· “Create folder when the folder not exists”
· If the designated folder in which to save the data does not exist, then that folder will be created

· I have not idea what happens if you uncheck this option
The final section lets you control the sample ID and whether or not it is used in the filename. This option contains some strange and annoying behavior. 
· if you want to use the sample ID in the filename, then you should check that “Use the sample ID in the file name” option. 
· You can give all scans the same sample ID, which you specify by checking “Use the same sample information in the entire batch” and then entering a sample ID. 
· If you do not check this option, then you will specify the sample ID for each scan individually in the Start window (this is commonly done for sample (changer) batches). 
The strange option is if you want every scan to have the same sample ID, but you do not want to use the sample ID in the filename. You must then:
1. Check “Use the sample ID in the file name”

2. Check “Use the same sample information in the entire batch”

3. Enter the “sample ID”
4. Uncheck “Use the sample ID in the file name”
6.4 Collecting Data using a Manual Scan

The manual scan executes a relative scan to collect data.  This is most often used to align the sample for GIXD, XRR, or rocking curve analysis. As such, there are several features to be aware of:

· Data are not automatically saved after the manual scan finishes. 

· To save data, right click on the scan window and select “Save”

· The shutter remains open after the scan finishes

· The count rate at the detector will be constantly updated

· The goniometer position can be changed after the scan finishes

· The manual scan window gives you options to move the scan axis after the scan finishes. This allows you to position the sample to achieve the maximum in intensity, for example. 

To run a manual scan,

· go to Collect > Manual Scan
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· configure the scan:

· specify the “Scan axis”, “scan mode”, “range”, “step size”, and “scan speed”
· section 6.1 describes these parameters

· Click on Start
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When the scan is finished, the shutter will stay open and you can move the goniometer along the axis that was scanned: more example, in the figure below we are moving Omega to the point where the intensity was maximized. 

To move the goniometer:

1. Right-click in the scan window
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You have two options to move the goniometer

a. Select Peak Mode to automatically locate and move to the peak position
i. The computer will automatically determine the position of the peak maximum

ii. You can then click on Move to and the goniometer will automatically move that position.
iii. You can also read values such as peak position, peak width, etc.
iv. The peak mode is sometimes more accurate if you zoom in on just the peak that you are interested in before running the peak mode analysis. To do this:
1. Right click on the scan window and select Zoom Mode
2. Left click and drag a box around the area of the peak that you want to analyze 
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b. Select Move Mode to manually located and move to the peak position
i. With the mouse cursor, click and drag the green line in the scan window
ii. The goniometer will move to wherever you position the green line
iii. Release the mouse button; the goniometer will move to that position
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To save the scan: 

1. Go to File> Save
2. Fill out the dialogue box

3. Click OK
[image: image125.png]@ save Measurement As

File
Mare:

Folder  |C:XPert Data

Sample D;

Comment:





When finished, you can either

· Collect another manual scan

· Go to the Prepare Manual Scan window

· Define the parameters for another scan

· Click start

· stop data collection and close the shutter

· Close the manual scan window.

VII. When You are Done

When you are done collecting data, you should turn the power for the diffractometer down. 

1. Go to the Instrument Settings tab

2. Double-click on Generator
3. Change the tube power

a. Change the values of “Tension (kV)” and “Current (mA)” to the desired values, and then click on OK. 

b. The resting power of the tube, when it is not being used, is 

i. For the Cu tube, set “Tension”=40kV and “Current”=10mA 

ii. For the Co tube, set “Tension”=30kV and “Current”=10mA 

4. To turn the tube power off, uncheck “Generator On” and click OK.
5. You can close X’Pert Data Collector by selecting File - Exit and pressing OK
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In general, you should always turn the generator power down to its standby level. 

The diffractometer should only be turned off when it will not be used for several days in a row, such as over a long weekend. 

You can now use X’Pert Data Viewer to view your results. A guide to using X’Pert Data Viewer is given in the X'Pert Explorer Add-ons Quick Start Guide (4022 339 07591). 

Appendix A
What PreFIX modules are available & how to decide what to use

The PANalytical X’Pert Pro features interchangeable modules for the optics on both the incident- and diffracted-beam sides; these are called “PreFIX Modules”. The PreFIX modules permit the diffractometer to be easily reconfigured as appropriate for individual experiments. 

For each PreFIX module there is also a range of accessories and settings that can be optimized for a given experiment.
The typical training for the X’Pert Pro will teach you how to change the accessories and settings of the PreFIX optics; however, it will not teach you how to change the PreFIX optics themselves. If you want to the PreFIX optics changed, then you should request help from SEF staff. 
The following is a list of PreFIX modules available for the X’Pert Pro diffractometer in the CMSE. 

A.1 Incident-beam PreFIX Modules
The incident-beam PreFIX modules condition the X-ray beam as it leaves the tube, and therefore affects the way the X-ray beam hits and interacts with a sample. There are two options for the incident-beam PreFIX modules, a programmable divergence slit (PDS) and an X-ray mirror. The PDS controls the divergence of the X-ray beam, while the mirror refocuses the divergent X-ray beam into a parallel beam. Using the PDS will tend to produce faster data collection and better angular resolution; while the parallel beam from the mirror produces more accurate peak positions and is necessary for GIXD, XRR, and residual stress measurements.

(1) Mirror Cu W/Si (parabolic MPD)
The graded multilayer parabolic X-ray mirror (i.e. Göbel mirror) is a beam conditioner that is able to convert the divergent X-ray beam into an intense monochromatic quasi-parallel beam. 

Unlike a divergence-limiting slit, which reduces the beam divergence by blocking all X-rays that are too highly divergent, the mirror collects the divergent beam and refocuses it. Consequently, X-rays are refocused instead of blocked, and the resulting X-ray beam is much more intense. The mirror accepts 0.8( of the X-ray beam from the tube. The quasi-parallel beam that leaves the mirror has less than a 0.05( equatorial divergence. The beam produced by the mirror can be between 1.2mm and 75m high; and between 30 to 4mm wide. 

The mirror does not restrict the axial divergence of the beam, so axial divergence limiting Soller slits are required. 

The mirror suppresses K-beta radiation to below 0.5% of its original intensity. Because the mirror monochromizes the beam, no diffracted-side filter or monochromator is typically needed unless the sample fluoresces.  

Advantages of the X-ray mirror include:

· When used in combination with parallel beam optics on the diffracted side, the observed peak positions in the diffraction pattern are not dependent on sample height. Consequently, errors associated with specimen displacement, specimen transparency, and the flatness of the specimen are eliminated.

· The mirror allows samples with irregular surfaces to be studied.

· The incident-beam intensity is increased.

· The mirror is optimized for thin film and reflectivity analysis.

The mirror is the best choice for:

· Grazing incidence angle diffraction (GIXD) for analysis of thin films

· X-ray reflectivity (XRR) from thin films

· Omega-stress analysis to determine the residual stress of a sample

· Diffraction from samples with an irregular surface

· Analysis of samples in glass capillaries
Pictures of the mirror and its accessories can be found in Figure 5.2 in Section 5.3A.

Accessories and settings for the mirror, from those closest to the beam to those furthest away, include:
Divergence Slit: ½°, ¼°, 1/8°, 1/16°, and 1/32° divergence slits are available. This slit determines the height of the X-ray beam produced by the mirror. A shorter beam is required to prevent beam spill-off at low incidence angles. The length of the beam on the sample is a function of the beam height, h, and incident angle, , as calculated in the equation: Irradiated Length =
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The beam height, and subsequent length, for each slit is:

	Divergence Slit
	Beam Height (mm)
	Beam Length (mm)
	Beam Length (mm) at =1( 

	½(
	1.2 mm
	0.12+1.2/sin()
	68.9 mm

	¼
	0.6
	0.12+0.6/sin()
	34.5

	1/8
	0.3
	0.12+0.3/sin()
	17.3

	1/16
	0.15
	0.12+0.15/sin()
	8.7

	1/32
	0.075
	0.12+0.075/sin()
	4.4


Beam Attenuator: A foil can be inserted into the beam path to reduce the intensity of the X-ray beam that exits the mirror. This is required when using the direct beam to adjust the sample height (i.e. shining the X-ray beam directly into the detector) or examining single crystal peaks. Available attenuators include the Cu 0.1mm, which has an attenuation factor of 75.9; the Ni 0.02mm, which has an attenuation factor of 2.37; the Cu/Ni 0.2/0.002mm, which has an attenuation factor of 19976.

Alternatively, the Soller slit housing on the end of the mirror can be replaced with an automatic beam attenuator. This attenuator automatically moves in and out of the X-ray beam depending on the strength of the beam hitting the detector, and consequently automatically protects the detector from saturation and damage. The automatic beam attenuator should be used when collecting XRR data or scanning single crystals or epitaxial films. The Ni 0.125mm automatic beam attenuator has an attenuation factor of 137.20. Only SEF staff can attach or remove the automatic beam attenuator. 

Figure 5.3 in Section 5.3A shows the difference between these two configurations. 
 Anti-scatter slit: The AS slit 1.4mm (mirror) should be used for measurements involving small angles of 2theta, such as XRR or low-angle diffraction. The anti-scatter slit can either be inserted in the Soller slit housing, in front of the Soller slits; or it can be screwed on to the end of the automatic beam attenuator. 
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Soller Slit: Either a 0.04rad, 0.02rad, or 0.01rad Soller slit can be inserted into the Soller slit housing. This slit limits the axial divergence of the X-ray beam. Axial divergence is the primary cause of peak asymmetry at low diffraction angles. By using smaller axial divergence Soller slits, the peak asymmetry can be better minimized; however, this also greatly reduces the beam intensity. A common approach is to use a larger Soller slit on the incident-beam side and a smaller Soller slit on the diffracted-beam side. 

Beam Masks: Beam masks can be inserted into the mirror in order to limit the width of the X-ray beam. The actual width of the beam on the sample is a function of the beam mask and Soller slit that are used:

	Beam Mask
	0.04 rad Soller slit
	0.02rad Soller slit

	20
	24mm wide
	22mm wide

	10
	14
	12

	4
	8
	6

	2
	6
	4


More information, along with pictures, is available in the User Guide, Part II, Chapter 6.

(2) Prog. Div. Slit & Anti-scatter Slit

Divergence slits limit the equatorial divergence of the X-ray beam and thus the amount (length) of the sample that is irradiated by the incident X-ray beam. 

The programmable divergence slit (PDS) is controlled in one of two modes:

· Fixed: the divergence angle is fixed at a set angle of 4(, 2(, 1(, ½(, ¼(, 1/8(, 1/16(, or 1/32(. When operating in such a mode, the length of the X-ray beam becomes smaller as the incident angle increases. 

· Automatic: instead of defining a set divergence angle, the irradiated length of the sample is defined instead. As the scan progresses, the divergence angle of the slit changes so that the length of the incident X-ray beam on the sample is kept constant.     

On the Data Collection computer for the PANalytical X’Pert Pro, there is an MS Excel workbook called “X'Celerator Calculation Sheet.xls”. The workbook can be used calculate the length of the X-ray beam for a given divergence angle (the Constant Divergence Angle worksheet) or the divergence angle of the X-ray beam for a given irradiated length (the Constant Illuminated Length worksheet). 

Pictures of the PDS and its accessories can be found in Figure 5.5 in section 5.3A. 
Accessories and settings for the Programmable Divergence Slit include:

Beam Attenuator: A Cu 0.1mm or Cu 0.2mm attenuation foil can be inserted in-front of the Soller slit in order to reduce the intensity of the incident X-ray beam. This is most useful when working with the direct beam for alignment or when examining single crystals and/or epitaxial films.

Filter: An incident beam beta filter can be inserted into the same slot that would hold the beam attenuator. Only one filter or beam attenuator can be used at a time. It is much more common to use a beta filter on the diffracted-beam side.

Soller Slit: Either a 0.04rad, 0.02rad, or 0.01rad Soller slit can be inserted into the Soller slit housing. This slit limits the axial divergence of the X-ray beam. Axial divergence is the primary cause of peak asymmetry at low diffraction angles. By using smaller axial divergence Soller slits, the peak asymmetry can be better minimized; however, this also greatly reduces the beam intensity. The most common approach is the same size Soller slits on the incident-beam side and diffracted-beam sides. The Soller slit assembly in the PDS must have a interlock lever attached to it in order for the beam shutter to open. 

Mask: This mask limits the width of the incident X-ray beam. The width of the X-ray beam is a function of the mask and the Soller slit that are used:

	Beam Mask
	0.04rad Soller slit
	0.02rad Soller slit

	20
	22mm wide
	19.5mm wide

	15
	17
	14.5

	10
	12
	9.5

	5
	7
	4.5


Fixed Anti-Scatter Slit: A fixed anti-scatter slit is attached to the end of the PDS module. This slit reduces the background noise observed by the detector, especially at low angles of 2theta. When the PDS is operated in fixed mode, then the anti-scatter slit should be twice the size of the divergence slit (i.e. a 1( anti-scatter slit if the PDS is set to ½(, etc.). When the PDS is operated in automatic mode, then the anti-scatter slit should be twice the size of the largest angle of the divergence slit. This can be problematic when using the automatic mode over a large range of 2theta; it might be better to divide the scan into two segments. 
A.2 Diffracted-beam PreFIX Modules
The diffracted-beam PreFIX modules intercept the X-rays scattered from the sample and condition them before they reach the detector. There are two options for the diffracted-beam PreFIX modules, the parallel plate collimators with point detector or the programmable anti-scatter slits with X’Celerator detector. The parallel plate collimators are combined with the incident mirror for parallel-beam geometry, while the X’Celerator detector is combined with the PDS for Bragg-Brentano parafocusing geometry. 

(1) Parallel Plate Collimators

We have two parallel plate collimator modules; the differ by the acceptance-angle of diffracted X-rays. These modules consist of a set of parallel plates that define the equatorial acceptance angle seen by the detector. The two collimators have a 0.09° acceptance angle and a 0.27° acceptance angle. A smaller acceptance angle means that the measurement is more nearly a parallel-beam measurement and has better resolution; however, the smaller acceptance angle also greatly reduces the intensity observed by the detector.  The parallel plate collimators are combined with the incident-beam side mirror and the mini-proportional point detector to perform parallel-beam measurements.
Pictures of the mirror and its accessories can be found in Figure 5.6 in section 5.3B.
Inserts and settings for the Parallel Plate Collimators include:

Receiving Slit: A Parallel Plate Collimator Slit can be inserted into the module. This is used to enhance the resolution, particularly at very low 2theta angles (<4() for XRR measurements. 
Soller Slit: Either a 0.04rad, 0.02rad, or 0.01rad Soller slit can be inserted into the Soller slit housing. This slit limits the axial divergence of the X-ray beam. Axial divergence is the primary cause of peak asymmetry at low diffraction angles. By using smaller axial divergence Soller slits, the peak asymmetry can be better minimized; however, this also greatly reduces the beam intensity. The Soller slit in the parallel plate collimator most defines the axial divergence of the observed X-ray diffraction pattern, and therefore is often set to the smallest value desired.

Monochromator: A diffracted beam flat crystal monochromator can be installed between the parallel plate collimator and the detector.  If the flat crystal monochromator is installed, the detector slit must be inserted into the slot for the receiving slit. The detector slit is labeled as Cu or Co, depending on the wavelength of the beam from the X-ray tube. 

A diffracted beam monochromator is used to reduce the background due to sample fluorescence and to eliminate spectral contamination such as the K-beta line.

Detector: the detector should be set to PW3011/20 (Miniprop, large window). This is a gas proportional point detector.

We do not have an anti-scatter slit, filter, or beam attenuator for the parallel plate collimators.

(2) X’Celerator 

or X’Celerator with Monochromator Cu
The X’celerator is combined with the programmable anti-scatter slit and optional monochromator for high-speed high-resolution X-ray diffraction. The X’celerator detector can be run in either scanning mode or receiving slit mode. 

· Scanning mode: the detector observes up to 2.1 (2theta of the diffraction pattern simultaneously. When compared to a point detector collecting data in 0.02( steps, this is like having 105 detectors lined up in a row. This increases the intensity of the diffraction pattern, effectively reducing the required data collection times. However, the data tends to be noisier than that collected with a point detector, especially at lower angles 2theta (<10(). 

· Receiving slit mode: the detector is used as a point detector rather than a position sensitive detector. The length of the detector used can be adjusted in order to virtually change the effective receiving slit size of the diffractometer. Useful for slow, but very high resolution, scans at low angles 2theta.

Pictures of the mirror and its accessories can be found in Figure 5.8 in section 5.3B.
Inserts and settings for the X’Celerator include:
Anti-Scatter Slit: the X’Celerator has a programmable anti-scatter (AS) slit. Like the programmable divergence slit (PDS), this slit can be configured in fixed or automatic mode. In fixed mode, the angle of the AS slit is set; it should typically be equal to the angle of the PDS on the incident-beam side. In automatic mode, the irradiated length of the sample is fixed; again, this value should be the same as that specified for the PDS.

Filter: a beta filter can be inserted to remove unwanted wavelengths of radiation from the diffracted beam. This filter works best to remove K-beta lines and some W-contamination radiation; however, it does not effectively remove background noise from fluoresced X-rays. For a Cu tube, the filter should be a Ni foil; for a Co tube, the filter should be a Fe foil.

Soller Slit: Either a 0.04rad, 0.02rad, or 0.01rad Soller slit can be inserted into the Soller slit housing. This slit limits the axial divergence of the X-ray beam. Axial divergence is the primary cause of peak asymmetry at low diffraction angles. By using smaller axial divergence Soller slits, the peak asymmetry can be better minimized; however, this also greatly reduces the beam intensity. The most common approach is the same size Soller slits on the incident-beam side and diffracted-beam sides. 

Monochromator: A diffracted beam monochromator, “Diffr. Beam Flat 1x graphite for Cu (X’Cel)” can be installed to remove background noise created by fluorescence from samples that contain iron (when using a Cu tube).
Beam Attenuator: A Cu 0.1mm or Cu 0.2mm attenuation foil can be inserted instead of the beta filter in order to reduce the intensity of the X-ray beam hitting the detector.

 There is no collimator for the X’Celerator modules. 

A.3 Sample Stages
We have five sample stages

Sample spinner and changer: this sample stage can automatically change between 15 samples loaded into a tray. The sample can also be spun during data collection to improve particle statistics. This is most useful for routine XRD studies. 

Open Eularian Cradle: this sample stage can hold large samples, up to 100mm in diameter, 25mm in height, and up to 150gm. The height of this stage can be changed; this is necessary for the precise alignment required for XRR and GIXD measurements. The sample can also be rotated in fixed angles around φ and tilted from -5( to +95( in the axial direction (ψ). This is useful for studies of epitaxial films and residual stress.
Max diameter: 100mm

Max height 25mm

Max mass 150 g

Multi-purpose holder: max diameter 55 mm; max height 25mm, 

Wafer holder: max diameter 100mm; thickness 0.35mm

Manual Z stage: max diameter 160mm; max height 10mm; max weight 75 g


Manual Z stage with center removed:

Spring Loaded Sample Holder for Flat Specimens: similar to the sample holder used in the Rigaku powder diffractometers, this can hold thin flat specimens with a maximum thickness of 5mm, a minimum width of 40mm, and mass of 50gm. This sample holder can also hold powders loaded into a flat specimen holder, such as those used for the Rigaku. 

HTK1200N Furnace: this sample stage can hold a powder or small solid specimen (with a diameter <20mm and a height <3.5mm). The sample can then be heated between 25 and 1200(C in air, a low vacuum (10-3 mbar), or inert gas (He, N2, Ar). 

Oxford Systems Cryostat: this sample stage can hold a powder or very small specimen and cool it down to 11 K in vacuum. 
Appendix B

Configurations for Common Applications
High-speed X-Ray Powder Diffraction (XRPD)
· Incident Beam Optics

· PreFIX Module: Prog. Div. Slit & Anti-scatter Slit

· Divergence Slit:

· Fixed mode: Divergence angle from 1/8( to 1(
· Automatic mode:  Irradiated length from 2 to 10mm

· Anti-Scatter Slit: twice the size of the divergence slit

· Mask: 10mm (sometimes 5 or 15mm, seldom 20mm)

· Mirror: none

· Beam Attenuator: none

· Filter: none

· Soller slit: 

· 0.04rad for high angle data for phase ID or quantitative analysis

· 0.02rad or 0.01rad for low angle data or Rietveld analysis

· Diffracted Beam Optics

· PreFIX Module: X’Celerator

· Anti-Scatter Slit: Prog AS Slit

· Same mode and size as Incident Beam Divergence Slit

· Receiving slit: none

· Filter: Nickel

· Soller Slit: same as on the incident beam side

· Monochromator: none

· Collimator: none

· Detector: X’celerator 

· Usage: Scanning

· Active Angle: 2.122

· Beam Attenuator: none

· Sample Stage: any

Grazing Incidence Angle X-Ray Diffraction (GIXD) 
· Incident Beam Optics

· PreFIX Module: Mirror Cu W/Si (parabolic MPD)

· Divergence Slit: Slit Fixed 1/16 or 1/32( 

· Anti-Scatter Slit: AS slit 1.4mm (mirror)

· Mask: none

· Mirror: Inc. Beam Cu W/Si (parabolic MPD)

· Beam Attenuator: none

· Filter: none

· Soller slit: 

· 0.04rad for high angle data for phase ID or quantitative analysis

· 0.02rad or 0.01rad for low angle data or Rietveld analysis

· Diffracted Beam Optics

· PreFIX Module: Parallel Plate Collimator 0.09( or 0.27(
· Trade-off between resolution (0.09() or intensity (0.27()

· Anti-Scatter Slit: none

· Receiving slit: none

· Filter: none

· Soller Slit: same as on the incident beam side

· Monochromator: none

· Collimator: Parallel Plate collimator

· Detector: PW3011/20 (Miniprop, large window)

· Beam Attenuator: none

· Sample Stage: open eularian cradle or spring-loaded sample holder

Small-Angle (High d-spacing) XRD
· Incident Beam Optics

· PreFIX Module: Prog. Div. Slit & Anti-scatter Slit

· Divergence Slit:

· Fixed mode: Divergence angle of 1/16( to 1/32(
· Automatic mode:  Irradiated length of 2 to 10mm

· Anti-Scatter Slit twice the size of the divergence slit

· Mask: 5 or 10mm

· Mirror: none

· Beam Attenuator: automatic

· Filter: none

· Soller slit: 

· 0.02rad or 0.01rad 

· Diffracted Beam Optics

· PreFIX Module: X’Celerator

· Anti-Scatter Slit: Prog AS Slit

· Same mode and size as Incident Beam Divergence Slit

· Receiving slit: none

· Filter: Nickel

· Soller Slit: same as on the incident beam side

· Monochromator: none

· Collimator: none

· Detector: X’celerator 

· Usage: Scanning

· Active Angle: 0.518

· Beam Attenuator: none

· Sample Stage: open eularian cradle or spring-loaded sample holder

X-ray Reflectivity 

· Incident Beam Optics

· PreFIX Module: Mirror Cu W/Si (parabolic MPD)

· Divergence Slit: Slit Fixed 1/32( 

· Anti-Scatter Slit: none or AS slit 1.4mm (mirror)

· Mask: none

· Mirror: Inc. Beam Cu W/Si (parabolic MPD)

· Beam Attenuator: Ni 0.125mm automatic

· Usage: at pre-set intensity

· Activate at level: 400000

· De-activate at level: 300000

· Filter: none

· Soller slit: none

· Diffracted Beam Optics

· PreFIX Module: Parallel Plate Collimator 0.09( or 0.27(
· Trade-off between resolution (0.09() or intensity (0.27()

· Anti-Scatter Slit: none

· Receiving slit: Parallel Plate Collimator Slit

· Filter: none

· Soller Slit: 0.04rad or 0.02rad Soller slit

· Monochromator: none

· Collimator: Parallel Plate collimator

· Detector: PW3011/20 (Miniprop, large window)

· Beam Attenuator: none

· Sample Stage: open eularian cradle

Rocking Curve or Reciprocal Space Map 

· Incident Beam Optics

· PreFIX Module: Mirror Cu W/Si (parabolic MPD)

· Divergence Slit: Slit Fixed from 1/32° to ½( 

· Anti-Scatter Slit: none
· Mask: none

· Mirror: Inc. Beam Cu W/Si (parabolic MPD)

· Beam Attenuator: Ni 0.125mm automatic

· Usage: at pre-set intensity

· Activate at level: 400000

· De-activate at level: 300000

· Filter: none

· Soller slit: none

· Diffracted Beam Optics

· PreFIX Module: Parallel Plate Collimator 0.09( 

· Anti-Scatter Slit: none

· Receiving slit: Parallel Plate Collimator Slit

· Filter: none

· Soller Slit: 0.04rad or 0.02rad Soller slit

· Monochromator: none

· Collimator: Parallel Plate collimator

· Detector: PW3011/20 (Miniprop, large window)

· Beam Attenuator: none

· Sample Stage: open eularian cradle

Residual Stress or Parallel-Beam XRD
· Incident Beam Optics

· PreFIX Module: Mirror Cu W/Si (parabolic MPD)

· Divergence Slit: Slit Fixed 1/2( 

· Anti-Scatter Slit: none

· Mask: none

· Mirror: Inc. Beam Cu W/Si (parabolic MPD)

· Beam Attenuator: none

· Filter: none

· Soller slit: 0.04rad Soller slit

· Diffracted Beam Optics

· PreFIX Module: Parallel Plate Collimator 0.09( or 0.27(
· Trade-off between resolution (0.09() or intensity (0.27()

· Usually will use the 0.27( collimator

· Anti-Scatter Slit: none

· Receiving slit: none

· Filter: none

· Soller Slit: 0.04rad Soller slit

· Monochromator: none

· Collimator: Parallel Plate collimator

· Detector: PW3011/20 (Miniprop, large window)

· Beam Attenuator: none

· Sample Stage: any
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Figure 2.1 


The enclosure for the X’Pert Pro MPD
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